
UNIT-I 
 
WHAT IS A COMPUTER? 
  
 A computer is an electronic device which processes information based upon the 
instruction provided and generates desired output. 
 Electronic devices, which can input, store, manipulate data and output 
information in a desired form. 
 Computer is a machine that processes data to give information. 
 

CHARACTERISTICS OF COMPUTERS 
 
The characteristics of computers, which made them so powerful and useful, are 
 

1. SPEED 
2. ACCURACY 
3. CONSISTENCY 
4. STORAGE 
5. VERSATILITY 
6. AUTOMATION 

 
SPEED 
 
 Computers are able to do all tasks at amazing speeds. Although the speed of the 
computer will depend on how powerful the computer is, it can still process a lot of data at 
high speed. The computers speed is measured in terms of Millions of Instructions per 
second also called MIPS.  For the personal computer, speed depends on the clock 
frequency expressed in MHz per second. 
   
ACCURACY 
 
 The computer does not make mistakes. Once the right instructions have been 
given to it, the chances of computer making errors are almost zero. If faulty instructions 
are provided for processing the data, obviously faulty answers will be given. This is 
called GIGO ie., Garbage In Garbage Out. 
 
CONSISTENCY 
 
 After doing work for some time humans become tired. But computers do not 
become tired. This leads to it giving a consistently good performance hour after hour. 
This is also called diligence. 
 
STORAGE 
 
 Computers come with large amount of memory. They can hold lot of data. 
computers can retrieve a particular piece of information from large amount of data in a 



short time. This is called retrieval of data. Storage of data and information on the 
computer allows reduction of paper filing and other mundane tasks. Storage is expressed 
in terms of Bytes like  
 
VERSATILITY 
 
 Computers are capable of solving various types of  problems. It is used both in 
simple activities such as preparing payroll and in complex activities such as controlling 
the aircraft. 
 
AUTOMATION 
 
 Computers have made automation of many complicated processes possible not 
only complicated processes but also some dangerous processes that pose health risks to 
human beings have been computerized. 
 

APPLICATION OF COMPUTERS 
 Computers are used everywhere. Some of the areas of computer applications are given 
below. 

1. Accounting: Computers are used to maintain accounts efficiently. Computers do 
inventory  management, financial  management and cash management very easily. 
In computerized accounting we can easily take the reports like trail balance, profit 
and loss account and balance sheet. 

2. Banking : Now a days all banks are computerized. Customer transactions are 
maintained by computers. Computer controlled Automatic Teller Machines 
(ATM) are used for cash withdrawals. 

3. Medical : In hospitals, Computers are used to maintain patient details, their 
diseases  and treatments given by the doctors. Also in hospitals, most of the 
equipments are computer controlled. The doctors use these equipments for 
effective diagnosis. 

4. Education : Computers can be used in education to teach students. Students can 
get most of the details using various websites available in the Internet. 

5. Designing : In textile business, It is used to draw a new designs. By using 
AutoCAD software, Engineers draw the blue prints of their proposed buildings. 

6. Transport : In railways, it used for reservation and cancellation of tickets in easy 
manner. Airways and shipping corporation use computers in their day-to-day 
activities. 

7. Communication:  E-mail, voice mail and Video conferencing are possible by 
using computers. Computers control telephone and mobile phone  communication 
also. 

8. Engineering :  Computer-aided manufacturing (CAM) software is used by the 
engineers to design new products before their manufacture. 

9. Entertainment :  Computers are used to play movies and to play games 
10. Publishing  : Publishers use computer to prepare and format the content of the 

book. 
11. Space Technology. Computers control space research stations. 



12. Insurance: Insurance companies use computer to maintain their policy holder’s 
details. 

13. Cinema : Computers are used for adding graphical effects in films. 
14. Defense : Computer is used to control missiles efficiently. 
15. Libraries : In library, Computers are used to maintain information about books. 

Book issues and receipts are fully controlled by the computers. Computers are 
used to calculate the penalty for overdue books automatically. 

 
 

CONCEPTS OF DATA AND INFORMATION 
 
 Computers have basic underlying principle on which it works computers can also 
be called an information processor because the computer processes data to give 
information. 
 
DATA 
 
 Data is a collection of numbers, alphabets or some facts and numbers. Data on its 
own is not that useful unless it is arranged or combined with some more data. 
 
 I / P values given to a computer for manipulation or processing 
Ex. 
 Raj scored 515 marks out of 600 --- 515 
 Ram scored 300 marks out of 600 --- 300 
 Comparing the 2 data use come to know--- 2 
 Raj has scored higher than ram did--- GT 300 
 
INFORMATION 
 
 When data has been worked upon to give something more useful to the user, it is 
called information. 
 The processed data, which is available at the output of the computer for direct use, 
is called as information. 
Ex. 
 Raj scored a higher % than ram did. 
 
PROCESSING 
 
 The work that is done on data is a process. Process can be anything like addition, 
subtraction or a comparison. It is this processing that converts data into information. 
 

I/P          Process                               O/P 

 
 

Data Processing Information 

Data is input into the computer. Computer processes the data as per our instructions. 



DATA INFORMATION 
Raw  (un Processed) 
 
A collection facts and numbers 
 
Not of much use. 
 
Get converted to information 

Processed (added intelligence) 
 
Organized and arranged data. 
 
Is always useful 
 
Can also get converted to data. 
 

 
TYPICAL COMPUTER SYSTEM 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A TYPICAL COMPUTER SYSTEM 
 
 The box kept beside the monitor houses some of the most important and delicate 
parts of the computer. The part of the computer that does all the work all the thinking or 
all the processing is called the central processing unit or CPU. 
 
 CPU consists of three parts, which are inside name. 

1. ALU 
2. Control Unit 
3. Memory Unit  

 

Input Unit Output Unit 

Memory Unit 

Control Unit 

ALU 

CPU 



ALU 
 
 The ALU takes care of all the mathematical and logical or comparison functions 
done by the computer. E.g.:- Addition, Subtraction, Multiplication, Division,  Greater 
than, Less than etc. 
 
 
CU 
 
 The control unit controls the entire operations of all the units of a computer.  It 
brings one instruction at a time from the memory, interprets it and obeys it by 
coordinating the working of all the other units.  In other words, this unit is considered to 
be the nervous system of a computer.  All the commands are regulated and controlled by 
this unit. 
 
MEMORY UNIT  
 

 This unit consists of locations or cells on which the data can be stored.  If you 
want to retrieve the data, the data can be retrieved from the same unit.  This unit consists 
of two types of memories, Permanent memory and secondary or auxiliary memory. 
 
INPUT UNIT 
 
 Input unit is used to receive data and instruction in a form that can be understood 
by the computers. I/p unit is that a part of a computer to which the data and instruction is 
feed. Its function is to read the information and transmit to the CPU. 
 
OUTPUT UNIT 
 
 On completion of the process the data are stored in the memory and control unit 
transfers the data in the memory unit to the o/p unit and it convert the information into 
the form of human readable languages. 
 

MEMORY CONCEPTS 
 
 The memory has made the computer the most versatile instrument or machine that 
man has ever developed. Memory enables the computer to learn and remember different 
types of functions making it a very efficient machine. 
 
MEMORY 
 
 Memory is what allows a person to remember things. “Memory is just a measure 
of an individual’s capacity to remember”. 
 



COMPUTER MEMORY 
 
 Computer memory is capable to store many programs that allow it to perform 
tasks. Comparing the computer memory with our own memory, our memory is not a 
physical entity, where as the case of the computer’s memory it does have physical 
appearance. Data is stored here before the processing takes place and is stored here after 
it is converted into information. Computer memory is a place that physically holds the 
data, for the instruction that is going to be processed. 
 
 Imagine a large sheet, with vertical and horizontal lines drawn on it the little 
squares formed by the intersection of the lines are called cells each cell is capable of 
holding or remembering some piece of data or information. 
 
 When some data is entered in the computer every small unit of data is placed in 
these tiny cells during the process and even after the data that is converted into 
information remains stored in these tiny cells.  
 

In computers everything is binary. As far as the computer is concerned all data is 
always numeric information is also numeric, but the computer can convert this into a 
form that we as users want and give it to us as text, numbers or even pictures.  Although 
the computer is dealing with text, it first gets converted to numbers, gets processed as 
numbers and then gets displayed again as text this sort of a conversions is done by using 
a standard coding procedure called ASCII 

 
 ASCII stands for American Standard Code for Information Interchange. ASCII is 
used as standard by the computing world to enable easy exchange of information between 
different countries or even different types of computer systems. 
 
 Computers use only the binary digits namely 0’s and 1’s. The numbers 0’s and 1’s 
denote the state of the circuits being “off” “on” respectively. 
 
Bits-Binary digits-0’s and 1’s 
1 byte-8 bits 
1KB (OR) 1KILOBYTE-1024 BYTES 
1MB (OR) 1MEGABYTE-1024 KB 
1GB (OR) 1 GIGA BYTE-1024 MB 
 
TYPES OF COMPUTER MEMORY 
 Based on the needs the memory in computers is classified into two types. 
 

1. Primary (or Internal Storage) 
2. Secondary (or External Storage) 

 
 
 
 



PRIMARY 
 
 This is of first importance, fundamental or basic 
 
SECONDARY 
 
 This is of second importance, something that is dependent. Storage here refers to 
the safe-keeping of data, information or programs. 
 

Primary memory- memory for immediate processing 
Secondary memory-memory for storing data, information and programs 

 
PRIMARY MEMORY 
 
 Primary memory is of the most importance to the immediate processing needs of 
the computer science this memory is found inside the box where the CPU too is found, it 
is sometimes also called the internal memory. This is of two types 
 

1. RAM (Random Access Memory) 
2. ROM (Read Only Memory) 

 
RAM (RANDOM ACCESS MEMORY) 
 
 RAM is essentially a read/write memory. Information can be written into and read 
from a RAM.  It is volatile in nature, i.e. it retains the stored information as long as power 
supply is not switched off. 
 
Ram chips may be classified as: 

1. Dynamic 
2. Static. 

 
Dynamic RAM chip consist of transistors and capacitors. The change on the 

capacitor must be periodically refreshed or recharged. 
 

Static RAM chop consist of combination of transistors & resistors. Static RAM 
does not require special regenerator circuits to retain the stored data.  More transistor and 
other devices are needed to store a bit static RAM.  These chips are more complicated 
than dynamic RAM. 
 
ROM (READ ONLY MEMORY) 
 

ROM is a permanent type memory.  Its contents will not lose when power supply 
is switched off.  Data is hardwired onto these chips at the time of manufacture and cannot 
be changed by the user. 

 
 



Though data is hardwired, the user is able to program the following types of ROM 
1. PROM 
2. EPROM 
3. EEPROM 

PROM, Programmable Read Only Memory allows micro programs to be fused 
into them.  Operations once written cannot be erased.  A fused link cannot be restored.  
PROM can be programmed only once. 
 
 EPROM, Erasable Programmable Read Only Memory makes it possible for the 
user to repeatedly erase and reprogram this ROM.  Exposing the EPROM to Ultra Violet 
rays of a specific frequency does erasing. 
 

EEPROM, an Electrically Erasable Programmable Read Only Memory can be 
programmed through the use of special electrical pulses. 
 
SECONDARY MEMORY 
 
 The secondary memory is found outside the CPU box and hence sometimes called 
the external memory or external storage. 
 

1. PUNCHED CARDS  
2. MAGNETIC TAPES 
3. FLOPPY DISKS 
4. OPTICAL STORAGE DEVICES 
5. FLASH DRIVES 

HISTORY OF COMPUTERS 
 
 Historians starts the history of calculation with the abacus (a wooden frame with 
balls) or beads strung on parallel wires of trace its origin to around 5000 B.C. It was used 
for performing simple calculations.  In the seventeenth century, John Napier a Scottish 
mathematician did considerable work on the aids for calculation.  In 1620, William 
Ougntred invented the slide rule.  This is a calculating device based on the principles of 
logarithms.  1642, basis Pascal invented the first machine; numbers were entered by 
dialing a series of numbers wheels.  Another series too then wheels transferred the 
movements to a dial which showed the results. 
 
 In 1822, Charles Babbage, a professor of mathematics at Cambridge University 
designed a machine called “Difference Engine”.  It performs simple computation needed 
for setting up trigonometric and logarithmic table.  In short time, he had developed a 
machine called prototype computer whish is the basic model of the computer. 
 
 In 1944, H.Aiken designed a machine called mark I.  The time taken for average 
multiplication of division was about 4” seconds respectively.  The results were printed at 
the rate of one result per 5 seconds.  

 
Charles Babbage (1822) is the father of modern day computer. 



GENERATIONS OF COMPUTERS 
 
 Electronic computers developed in five different phases known as generations of 
computer.  Each phase is characterized by type of switching circuits. 
 
1st Generation Vacuum tubes 1940 – 1956 
2nd Generation Transistor (flip-flop) 1956-1963 
3rd Generation Integrated circuits 1964 – 1971 
4th Generation Large scale integrated on a 

micro-chip(Microprocessor) 
1971 - present 
 

5th Generation artificial Intelligence Present and Beyond 
 
FIRST GENERATION 
 
 First generation computers used vacuum tubes and programming was done in 
machine languages.  All the computers were of very big sizes and costly. 
 
The first generation computers had the following limitations 
 

1. Slow operating speed and restricted computing capacity. 
2. High power consumption. 
3. Very large space requirement. 
4. Limited programming capabilities. 

 
The trends which were encountered during the era of first generation computer were. 
 

1. The first generation computer control was centralized in a single cpu. 
2. Punched cards were used as input device. 
3. Magnetic tapes and magnetic drums were used as secondary memory. 
4. Primary code or Machine language was used for programming. 
5. Assembler, a program which translates assembly language program to 

machine language was made. 
6. Computer was accessible to only one programmer at a time. (Single user 

environment). 
 
The famous computers of this generation were. 
 
 ENIAC, EDSAC, EDVAC, LEO, UNIVAC-1, IBM-701 and IBM-650 
 

ENIAC: Electronic Numerical Integrator and Calculator which was completed in 
1946 was the first Electronic Calculator.  It performs 5000 additions/sec and consumed 
150 kilowatts of power. 
 
 EDVAC: Electronic Discrete Variable Automatic Computer Which was a 
computer build by the more school personnel and the Ballistics Research Laboratory of 
the US Army in between 1947-1950 



SECOND GENERATION 
 
 Second generation began with invention of transistors.  The transistor was at work 
in the computer.  Coupled with early advances in magnetic-core memory, transistors led 
to second generation computers that were smaller, faster, more reliable and more energy, 
efficient.  The high level languages like FORTRAN, COBOL and ALGOL were 
developed. 
 
 The use of transistors reduced 
 

1. Size 
2. Manufacturing and running costs 
3. Reliability and processing power. 

 
Some of the second generation computers were 
 
 IBM-1620, IBM-1401, IBM-1094, CDC-1604, CDC-3600, RCA-501, UNIVAC-
1108, LEO MARK-111, ATLAS, ICL-1901 etc 
 
THIRD GENERATION 
 
 Third generation computers had integrated transistor circuit (IC) having higher 
speed, larger storage capabilities and lower prices.  These computers were called mini 
computers. 
 
 Multiprogramming was well developed to allow the simultaneous execution of 
many program segments interleaved with I/O operation. 
 
 Many high-performance computers, like IBM 360/91, TI-ASC, CYBER-175, 
STAR-100 and CMMP were developed. 
 
FOURTH GENERATION 
 
 The development of micro processor made it possible to place complete control 
processing unit of a computer on a single chip.  Very large scale integrated having about 
50,000 transistors on a chip, made it possible to have micro computers of fourth 
generation.  Magnetic core memories were replaced by semi conductor memory. 
 
 The present generation computers emphasize the use of large-scale integrated 
(LSI) circuits for both logic and memory sections. 
 
 IBM introduced its personal computer (PC) for use in the house, office and 
schools, uses controlled the screen cursor using a mouse. 
 
 



 As smaller computers become more powerful, they could be linked together, or 
networked, to share memory space, software, information and communicate with each 
other.  As opposed to a mainframe, which was one powerful computer that shared with 
many terminals for many applications, networked computers allowed individual 
computers to form electronic co-ops. 
 
FIFTH GENERATION 
 
Defining the fifth generation of computers is somewhat difficult because the field is in its 
intense.  The most famous example of the fifth generation computer is the HAL 9000. 
 
 HAL performed all of the functions currently envisioned for real-life fifth 
generation computers.  Many advantages in the science of computer design and 
technology are coming together to ensure the creation of fifth-generation computers.  
 
 Two such engineering advances are  
 

1. Parallel Processing. 
2. Superconductor Technology. . 

 
TYPES OF COMPUTERS 

 
 Computers can be broadly classified on the basis of purpose, components and size 
and processing power. 
 

PURPOSE 
 

Analog computers 
Digital computers 
Hybrid computers 

 
ANALOG COMPUTERS 
 
 Analog computers are computers that measure physical quantities (eg. Pressure, 
temperature, length etc) and convert them to numeric values.  For eg a thermometer does 
not perform any calculations but measure the temperature of the body by comparing the 
relative expansion of mercury. 
 
 Analog computers are used mainly for scientific and engineering purposes 
because they deal with quantities that very constantly. 
 
DIGITAL COMPUTER 
 
 Most computers are digital devices ie they process information using numbers, 
which is essentially in a binary or a 2 state format 
 



 
 Special purpose digital computers can be fixed permanently into the machine, for 
example processors that are installed in automobiles to control fuels, breaking system etc. 
HYBRID COMPUTERS 
 
 The features of analog and digital machines are combined to create a hybrid 
computing system for e.g. analog devices measures patient’s vital signs like temperature, 
heart functions, etc.  These are then converted to numbers and supplied to a the digital 
computers that monitor the patients vital signs. 
 
SIZE & PROCESSING POWER 
 

1. Micro computers 
2. Mini computers 
3. Mainframe  
4. Super computer 

 
MICRO COMPUTERS 
 
 The microcomputer is the smallest type of computer. Inside a micro-computer, the 
arithmetic and control unit are combined on a single chip called a micro-processor.  
Micro-computers contain two types of storage or memory. 
  RAM 
  ROM 
 Micro computers are used as home computers for the family or personal 
computers by business executive or by small business where volume of data processing 
and speed are small. 
 
MINI COMPUTER 
 
 Mini computers are more powerful than the microcomputers and supply several 
users.  They have larger RAM and backing storage capacity and can process data more 
quickly. 
 
 A medium sized organization may use it for applications like processing of 
payrolls and financial accounts, handling costing, sales analysis, production planning and 
minicomputers may also be used for system like reservation or banking. 
 
 Eg. PDP-11, VAX 7500, AS400 
 
MAINFRAME COMPUTERS 
 Very large computers with a very high capacity of main store 

1. larger computer 
2. high storage capacity 
3. larger amount of data process very quick 

            very big organization  can use this computers      e.g. IBM 4381 



 
 
SUPER COMPUTER 
  
 Used for complex scientific applications like weather forecasting. In this type of 
computer very large amount of data are to be processed within a very short period of 
time. 
 
Eg. CRAY XMP-24. 
 

INPUT DEVICES 
 
 The purpose of having such device is to present information to the computer.  The 
input device feed the information in to the computer. 
 
 A medium that allows the user of the computer to enter data and instructions 
inside the computer is called an input device. 
 
KEYBOARD 
 
 A small flat piece of plastic board with several buttons arranged on it is called a 
keyboard.  These buttons are marked with capital alphabets from A to Z.  Another set of 
buttons has numbers from 0 to 9 more buttons with mathematical signs like + for 
addition, - for subtraction, * for multiplication, and / for division are present.  Then there 
are some buttons that have some special sign like: ,.””?\@$!%&()etc. All these buttons 
are called keys; the arrangement of the keys on the keyboard is some as ordinary 
typewriter.  Most computers have keyboards with 104 keys. 
 
MOUSE 
 
 Keyboards are still very popular for typing data for giving short instruction to the 
computer, the mouse has become very convenient.  The user of the computer just has to 
point at the instruction that he wants the computer to carry out. 
 
 Accordance with the mouse movement, an arrow or any other symbol moves in 
the monitor, thus we select the command by moving arrow and press the button on the 
mouse. That particular command executed by pressing the button on the mouse is known 
as clicking the mouse. 
 
BAR CODE READER 
 
 In some articles, number of small bars is printed to represent code number and 
price.  These are called as Bar Codes. A handy device called bar code reader can read 
such cods. They are connected to the computer.  The user moves the bar code on the bar 
code reader, the computer reads the information and stores it.  Then the computer 
calculates the value corresponding to the code and prints the bill. 



 
MICR READER 
 
 MICR means Magnetic Ink Character Recognition.  MICR is a device which can 
sense characters as they scan the characters.  It consists of characters of standard type.  
All the characters formed by making the correct combinations of boxes.  It is used to read 
the details in a cheque. 
 
OCR 
 
 OCR means Optical Character Reader.  OCRs scan the text optically, character by 
character, conquered them into a machine readable code and store the text on the 
system’s memory.  They can read at a rate of up to 2,400 characters per second.  It is used 
for validating examination paper and application forms. 
 
LIGHT PEN 
 
 The light pen is a digital input device.  It is used as a pointing device.  With this 
device the user will point, to do an operation like drawing a line or rotating an object on a 
CRT.  Light pen, in combination with a video screen is used to display or modify images 
on the screen.  This is carried out by placing the tip of the light pen, across the surface of 
the screen to trace the outline of the image to be displayed.  The light pen is an electronic 
device in the form of a photo diode.  The computer detects the location of the pen on the 
screen surface by counting the number of vertical and horizontal synchronization pulses. 
 
JOYSTICK 
 
 The joystick is used as a graphical input device.  Like a mouse, it converts a 
user’s graphics moment into changes in voltage.  It also used to variable resistors to 
specify the movements in X and Y directions.  Here the movement is caused by pushing a 
handle which is available on the upper portion of the joystick is similar to the mouse. 
 
DIGITAL CAMERA  
 
A digital camera can be used to take pictures.  It can be hooked up to a computer to 
transfer the pictures from the camera to the computer.  Some digital cameras hold a 
floppy disk, and the floppy disk can be taken out of the camera and put directly into the 
computer. 
 
MICROPHONE  
A microphone is used to record sound.  The sound is then saved as a sound file on the 
computer. 
 
 
 
 



SCANNER  
A scanner is used to copy pictures or other things and save them as files on the 
computer.  
CAMERA 

Most of  cameras like this are used during live conversations.  The 
camera transmits a picture from one computer to another, or can be used 
to record a short video. 

 

 
 
TRACKBALL 
 

 Instead of moving the whole mouse around, the user rolls the 
trackball only, which is on the top or side. 

 
 
GLIDE PAD (TOUCH PAD) 
 

 Uses a touch sensitive pad for controlling cursor. The user slides 
finger across the pad and the cursor follows the finger movement. 
For clicking there are buttons, or you can tap on the pad with a 
finger. The glide pad is a popular alternate pointing device for 
laptops.  

 
TOUCH SCREEN 

 Make selection by just touching the screen. 

 
 

OUTPUT DEVICES 
 
 The device that will give the processed data or information to us is called the 
output device. 
 
 The device, which is used to communicate the processed information to the user, 
is called output device. 
 
 This device translates the processed date from a machine-code form to a form that 
can be read and used by people. 
 
 



CATHODE RAY-TUBE (CRT) 
 
 The working of CRT is most similar to the working of the TV screen.  Here an 
electronic beam hits a phosphor-coated surface because of which light is emitted.  By 
controlling the electron and its intensity, we can generate character and graphics on the 
screen.  By employing horizontal and vertical deflection circuitry, the electron beam is 
more across the screen. 
 
 The traveling of electron beam from top left to bottom right of the screen, line by 
line is called scanning. The scanning of electron beam from left to right is called the 
trace.  The scanning of electron beam from right to left is called retrace.  A dot or a point 
on the screen is called pixel. Number of pixels per unit area is called resolution of the 
monitor.  Monitor is of two types 

1. Monochrome 
2. Color. 

 
In monochrome monitors, the letter appears in gray or white color.  Since there is 

only one colors being used, it is called monochrome (mono-single, chrome -color) 
 
Color monitors can display text and pictures in all colors.  Some recently 

developed monitors have as many shades as your TV at home. 
 
GRAPHICS PLOTTER 
 
 Potters are used to produce output containing graphics or diagrams with the 
availability of multi color plotters they are increasingly used for preparing financial 
documents, annual reports and engineering drawings. 
 
 Plotter may use either pen or inject approach.  Pen plotter is available in two 
forms. 

1. Drum type 
2. Flat Bed type 

 
In drum plotter, both paper and pen moves, while in the flat bed plotter, the paper 

is fixed and the pen moves.  The injection plotter was jets of ink with different colors and 
is able to produce large drawings containing many colors. 

 
PRINTERS 
 
 The paper copy obtained from a printer is often referred to as the printouts.  The 
output can be obtained from printers are available with variety of printing mechanisms 
and speeds and varying quality. 
 
 Based on the printing style, the printers are classified as 

1. Impact Printers 
2. Non-Impact Printers. 



IMPACT PRINTER 
 Impact printers are those which have contact between the keys, the ribbon and the 
paper and there will a impression found on the paper due to the striking of keys. 
 

1. Dot Matrix Printers. 
2. Daisy Wheel Printers. 
3. Line Printers. 

 
NON – IMPACT PRINTERS 
 Non Impact printers are those which have no contact between the keys, the ribbon 
and the paper and there will be no impression found on the paper due to the spraying 
method of inks. 
 

1. Laser Printers. 
2. Inkjet Printers. 

 
DOT MATRIX PRINTER 
 
 The matrix printer is another impact printer, which prints one character at a time.  
The print head compress a matrix of tiny needles, usually seven rows and five columns 
they are electrically driven and print character in the form of patterns of fine dots.  The 
pattern of dots for each character is dictating by instruction held. 

  
DAISY WHEEL PRINTERS 
 
 A daisy wheel printer is also a character printer and derives its name from the 
shape of the print wheel used in it. The wheel rotates at high speed and when the required 
character is positioned over the ribbon, a tiny hammer strikes it against the ribbon thus 
transferring the character symbol to the paper. These are slow printers, with speeds 
ranging from 17 to 200 characters per second. 
 
LINE PRINTERS  
 
 A line printer which prints an entire line at a time instead than printing a character 
It is the fastest printer. Its speed varies from 300 to 3000 lines per minute. It has been 
used in data processing applications for many years. They have normally 132 print 
positions per line. Speed is the obvious advantage of this type of printer. The major 
disadvantages are noise and relatively poor image quality. 
 
LASER PRINTERS 
 
 Laser printer technology has much less mechanism than impact printing, resulting 
in much higher speeds and quicker operation. A laser beam is directed across the surface 
of a light sensitive drawn and fired as needed to record an image in the form of a pattern 
to tiny dots. The image is then transferred to the paper, a page at a time, in the same 
fashion as a copy machine, using as special toner. 



The major advantage of laser printers is 
1. Very high speed. 
2. Low maintenance required. 
3. Low noise level. 
4. Excellent graphics capabilities 
5. A variety of type size and styles. 

 
INKJET PRINTERS 
 
 Inkjet printers work in much the same fashion as dot-matrix printers is that they 
form images or characters with little dots. The dots are formed not by hammer like pins, 
but by tiny droplets of ink. These printers almost matches the speed of dot-matrix 
printers, up to about 270 cps, they produce less noise and produce better latter quality. 
Some of the printers come with all their color inks in a cartridge, if you want to replace 
one color, you must replace all the colors. Other color ink-jet printers allow you to 
replace inks individually. These printers are better choice if you use one color 
predominantly. 
 

DATA STORAGE DEVICES 
 

 
The purpose of data storage device is to retain data and programs for future use. It helps 
the user to store data, information and various softwares for later use. 
 
 The popular external storage media used computers are 

1. Floppy disks 
2. Hard disks 
3. Magnetic tapes 
4. Optical/compact disc. 
5. Blu- rays Disc 
6. USB Flash Drive 

 
 
1. FLOPPY DISKS 
 
Floppy disk is the most common storage medium used on small computers. It is a flexible 
plastic disk coated with magnetic material and looks like a phonograph record. The disks 
are permanently enchased in stiff paper jacked for protection and easy handling. An 
opening is protection and easy handling. An opening is provided in the jacket which 
facilitates reading and writing of information. Floppy disks are available in three standard 
sizes namely. 
 
Floppy Disk-5.25” -, 320 KB. 
Floppy Disk - 3.5” - 1.44 MB. 
 



2. HARD DISKS 
 
The hard drives are one of the most important of the secondary types of computer data 
storage device. Data is stored on the hard drives in the digital format on the hard drives. 
In the initial days of the computers, hard disks were like removable mass storage devices. 
However, with time they started coming as a part of the central processing unit of the 
computer. However, now there are external hard drives available as well. 
 
3. MAGNETIC TAPES 
 
 Magnetic tapes are plastic types created with magnetic material such as ferrous 
oxide.  By passing this type under a coil where the data is feed in the form of current, we 
can magnetize the tape.  For reading back, the tape is passed under a coil.  Because of the 
magnetic force, a current is induced in the coil, which is then processed by electronic 
circuits, which converts in into digital data.  The records are stored in block forms and are 
separated by an identification gap called Inter Record Gap or Inter Block Gap [IRG] 
 
4. COMPACT DISKS:[ Optical Disks] 
 
4.1.CD-ROM (Compact Disk – Read Only Memory) 
 
 The disk manufacturer imprints this optical disk’s data.  The user cannot erase it, 
change it, or write on the disk, the user can only ‘read’ the data. 
 
4.2.DIGITAL VERSATILE DISC (DVD) 
 

The format of storing data in the digital versatile discs (DVD) is similar to that of a 
compact disc. The difference lies in the storage capacity. There is six times more storage 
space in the DVD’s as compared to the CD’s. Like the CD’s, DVD’s are also used as 
backup device. 
 
5. Blu-rays Discs 
 
Blu-rays discs are abbreviated as BD, are used for high definition video storage. It is 
often used by gamers. Blu-ray discs are similar to the CD’s and DVD’s in their looks. It 
is the memory space which makes all the difference between the CD’s, DVD’s and BD’s. 
Blu-ray disc is an optical storage device. 
 
 
6. USB Flash Drive 
 
The USB flash drive has an integrated Universal Serial Bus (USB) interface. They are 
non-volatile and data can be rewritten on them. They are very small in size, but have very 
large memory space. There are some of the USB drives, where 1 million erase and write 
cycles can be carried out. On the other hand, some of them are known to retain data for as 
long as 10 years. 
 

http://www.buzzle.com/articles/external-hard-drives/
http://www.buzzle.com/articles/bluray-discs/
http://www.buzzle.com/articles/usb-flash-drives/


HARDWARE AND SOFTWARE 
 
A computer system is a combination of Hardware and Software. 
 
HARDWARE 
 
 Hardware refers to the physical components/parts of the computer such as 
electronic circuits, keyboards and bolts and nuts that goes to make the computers. 
 
 The physical equipments and components which we can see, touch and feel in the 
computer system are called as hardware. 
 
SOFTWARE 
 
 Software is the set of instructions given to the computer, which helps the 
computer to process data with give information.  In other words, it is defined as a set of 
programs given to the computer. 
 
 Software is an individual or a group of programs or instructions given to the 
computer to perform a particular task. 
 
 Software is classified into two broad categories 

1. System Software. 
2. Application Software. 

 
SYSTEM SOFTWARE 
 
 System software is a set of programs that manage the resources of a computer 
system, control and monitor various activities and makes it easier and more efficient to 
use the computer. 
 
 System software consists of general programs that assist the computer in the 
efficient control, support, development and execution of application programs. 
 
System software is classified into three categories. 

1. System Control Software (Program that manage system resources & function). 
2. System Support Software (Program that support the execution of various 

applications). 
3. System Development Software (Program that assist system developers in 

designing and developing information system). 
 
SYSTEM CONTROL SOFTWARE 
 
 System control software includes programs that monitor, control, coordinate and 
manage the resources and functions of a computer system.  The most important system 
control software is operating system. 



 
SYSTEM SUPPORT SOFTWARE 
 
 System support software is software that is software that supports, or facilitates, 
the smooth and efficient operation of a computer these one four major categories of 
system support software: Utility programs, language translators, database management 
systems & performance statistics software. 
 
SYSTEM DEVELOPMENT SOFTWARE 
 
 System development software helps system developers design and build better 
systems. An example is Computer – Aided Software Engineering, or CAS, a collection of 
programs that Assist developers in developing an information system. 
 
APPLICATION SOFTWARE 
 
 Application software is programs that work for human related tasks such as 
payroll, inventory and sales analysis. There are two types of application software: 

1. General – purpose software. 
2. Application – dedicated software. 

 
GENERAL – PURPOSE SOFTWARE 
 
 General purpose software is mass produced for a broad range of common business 
applications such as word processing graphics, payroll and accounting some popular 
general purpose software programs are word processing, desktop publishing, accounting 
software, etc. 
 
APPLICATION – DEDICATED SOFTWARE 
 
 Application – Dedicated software includes specialized or customized applications 
designed for very specific purposes.  For example, software designed to cater the delivery 
of goods and services to a customer’s door step is highly specialized. 
 

 
ROLE OF SOFTWARE 

 
Some of the applications for which the computer is used are 

1. Letter writing 
2. Publishing 
3. Keeping records 
4. Performing mathematical calculations 
5. Painting and drawing. 
6. Telecommunications. 
7. Games. 

 



LETTER WRITING 
 
 Software that allows us to type any data, letter, report or a story and also allows us 
to make corrections on the mistakes occurred while typing without wasting paper and the 
human energy is called a word processor.  The typed data is stored in the RAM of the 
computer and if there is any mistakes occurred, it can be corrected and can be saved.  
Then the printouts can be taken when we are satisfied by the corrections made. 
 
 The most commonly used word processors are MS-WORD, WORD PERFECT, 
ETC., 
 
PUBLISHING 
 
 Publishing refers to the collection of several pieces of text, combining it with 
pictures and printing it in an attractive form.  The most commonly found published 
material we read every day is the News Paper.  This process is quite lengthy, messy; now 
software that helps in the collection and arrangement of this is called Desktop Publishing 
because every work can now be done on the ‘top of our desk’ (Commonly called as 
DTP).  Some most popular ones are Page Maker & Ventura. 
 
KEEPING RECORDS 
 
 All the data that we collect for processing needs to be stored and the information 
we generate needs to be maintained.  The list must be made and kept handy.  If we have 
any new data, it must be added to the list.  This is called updating the list.  For 
maintaining a huge data like books in the library of a university, database software is 
available for maintaining this huge base of data. 
 
 Examples of database programs are DBASE, and Oracle. 
 
PERFORMING MATHEMATICAL CALCULATIONS 
 
 Computer is very good at handling all types of mathematical problems since it 
turns everything into numbers.  SPREADSHEET is the main software used to do the 
process and it allows to enter a lot of number and perform many types of calculations,  it 
allows to decide which number can be added, divided or whose percentage has to be 
calculated.  Some common spreadsheets available are EXCEL, LOTUS 1-2-3, etc., 
 
PAINTING AND DRAWING 
 
 Drawing a straight line in computer is very easy.  To draw a straight line on the 
computer all you have to do is make on the screen where the line should start and end.  
The software available for making drawings on the computer allows the artist to 
 Create & edit freehand drawings. 
 Refine parts of those drawings. 
 Combine 2 different drawings to produce a new one. 



 Fill up a drawing white colors. 
 Change the size of those drawings are per the user’s requirements. 
 
The popular drawing packages are Paint, Paint brush, etc., 
 
TELECOMMUNICATIONS 
 
 The term ‘telecommunication’ refers to communication done over long distances.  
Telephones help us to talk over long distances and even across continents cable 
televisions allows us to watch the programs of counters across the oceans.  All this is 
possible due to telecommunications.  Specific software is now available that helps 
computers communicate with each other matter where they are in the world. 
 
GAMES 
 
 Playing games on the computer is one of the common uses of the computer games 
have gone a long way in making the computer popular.  It is one software that thrills 
users of all ages because of the variety of software that is available to the users. 
 
READYMADE SOFTWARE 
 
 The software which is written previously or programmed previously for general 
purpose and sold in shops is called readymade software. 
 

HOUSE KEEPING 
 
 Take care or maintaining the parts and software’s are apart of house keeping.  To 
make the most out of any machine it has to be. 
 
Use properly. 
The parts have to be kept in good condition. 
Any break-downs have to be repaired immediately. 
Records of all the break-downs have to be kept regularly. 
Sufficient training on how to use the machine has to be imparted to the users. 
 
 This process is often called as house keeping.  House keeping in computers refers 
to the maintaining of the computer hardware, the computer software and the data. 
 
MAINTAINING COMPUTER HARDWARE 
 
 The parts of the computer that are most likely to get affected by repeated use are. 
 
DISK DRIVES 
 
 The disk drives need to be cleared from time to time using the tools that are 
available. 



 
PRINTER 
 
 Printer creates a lot of paper dust.  This needs to be cleaned once in every 15 day 
depending on the usage. 
 
HARD DISK 
 
 The computer should not be switched off when a program is working. 
 
FLOPPY DISK 
 
 The computer should never be switched off without removing the diskette from 
the drive.  Doing this will cause the data on the disk to be lost or will damage the disk all-
tougher. 
 
MOUSE 
 
 The mouse has to be cleaned every month.  It is best to use the mouse on the firm 
and smooth pad. 
 If any error occurs on the computer, it must be communicated to the engineer 
keeping the record of the exact nature of the breakdown. 
 
MAINTAINING COMPUTER SOFTWARE 
 
 Software or programs too have to be looked after all the programs or software 
should be copied on a set of disks to avoid problems in case the original copy on the hard 
disk gets erased by mistake.  This procedure is known as taking a backup. 
 
MAINTAINING DATA 
 
 For example, typing a huge number of pages of data, if the data typed get lost by 
some reason.  All the energy, time and efforts spent for typing the data will be waste. 
 
 Back up are nothing but exact copied of the data that is stored on hard disk.  This 
copy is taken in floppy disks, magnetic tapes or CD. 
 
 The various reasons, which could lead to data loss 
 Power failure 
 Surges in power (fluctuation in voltages) 
 Computer breakdowns 
  
 Backup is the most important work that needs to be carried out at the end of 
working time on the computer.  This process is also called the day and procedure. 
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UNIT II 
 

The Computer Internals 
 
 The computer is a result of many small parts which works each other in  smooth 
coordination.  Those are:- 
 

1. Bus, Port, Cards and Motherboard. 
2. Memory 
3. Hard disk drive 
4. Floppy disk drive 
5. Power supply unit 
6. Computer clock 

 
 

Bus, Port, Cards and Motherboard 
 
 Millions of data and instructions are speeding along, through the components of your 
computer.  This is happening even while your computer seems to be idle.  Like  a busy 
highway which has many policeman regulating heavy traffic, the input/output work in a 
computer is controlled by controllers which work with the processor to make sure that there is 
no clash of data. 
 
 The bus in a computer system transfers the data and controls around the internal parts 
of a computer system.  There are several types of buses that facilitate transfer of data.  One is 
the data bus. The bus which controls all the data flow is the control bus.  A bus is not a single 
part of the computer. It is actually a complex group of circuits.  These circuits are present all 
over the motherboard. 
 
 The microchips that are seen inside the computer are also called buses.  These 
microchips allow the computer to include more ports.  For this purpose, they have slots in them 
in which cards can be included.  Hence this bus which allows the expansion of the computer is 
called the expansion bus.   
 
 While the transfer of data takes place through the bus, the entry and exit point of these 
buses is called ports.  Some ports allow only a serious of data to pass through.  Such ports are 
called serial ports.  ‘serial’ refers to the fact that the entry of data bits happens in a line one 
after the other.  Naturally, the time that will be taken for data transferred from one place to 
another will be more because only one bit is allowed to enter or exit at any point of time. 
 
 Serial port is used mostly with the mouse.  It is also sometimes called RS-232. 
 
 Some ports allow the passage of more than one bit i.e., 8 bits at a time.  Such ports are 
called parallel ports.  Transfer of data is much faster than the serial port.  These ports can 
transfer the entire word ‘computer’ from one part of the computer to another part.  These ports 
are used with the printers.  These are some times called as printer ports. 
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Memory 
 
 RAM chips are used in group of 9, each holding the same number of bits.  RAM is 
usually solid and installed to a standard adding board called Single In-Line Memory Module or 
SIMM. 
 

Hard disk drive 
 
 This is the work house of the computer.  This can be thought of as a collection of many 
floppies or gramophone record stacked on each other without all of them actually touching 
each other.  These are caked platters.  The gap between these platters is as thin as a human hair.  
The data stored on these platters may actually be the result of years and years of work.  The 
platters plate at a very high speed all the time, when the computer is on.  Whenever any data is 
read or written is done on read and write heads.  The full set of these platters and the read and 
write heads is enclosed a vacuumed container to protect it from dust and electrical shocks. 
  
 

Floppy disk drive 
 
 A floppy disk allows information to be changed between two computers.  The floppy is 
actually enclosed in a plastic jacket that protects it from heat, dust and electrical shocks.  When 
a floppy is imposed to any of the above the following two things can happen. 
 

1. The floppy can be physically damaged, which can lead to loss of the data which is 
on the floppy. 

2. The floppy may remain intact, but there may still be a data loss. 
 
 
One way to avid the loss of data in the floppy is to label the floppy correctly as a 

backup floppy.  This would certainly avoid such an accident.  Another more effective way 
would be to write protect the floppy, i.e. protect it from being written on. 
 
 

Power supply unit 
 
 The power supply unit checks the quality of the power supply and ensures that the right 
amount of power gets supplied to the various parts of the computer. 
 

Computer clock 
 
 All computers have a real clock built inside them which is attached to the motherboard.  
This clock works on a separate battery source.  Therefore it remains working even when the 
computer’s power supply is switched off. 
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Typical pc configuration 
 
 Configuration refers to the manner in which the hardware and software of an 
information processing system are organized and interconnected.  When a computer is bought, 
it has to be configured, configuring a computer is a process that describes the devices and 
optional features and programs that the system will have. 
 
 The specifications for these will keep changing because technology is advancing at a 
very rapid pace. 
 

Booting a computer 
 
 When you switch on a computer, it goes through a complex set of instructions.  This is 
to ensure that all its components are working properly and if something is found wrong, it is 
able to give warning to the user.  This is the first step of a very complex process called booting. 
 

 

Power-On Self Test 

As soon as you turn on a computer, its central processing unit (CPU) begins to carry out the 
programming instructions contained in the basic input/output system (BIOS). The first set of 
startup instructions is the power-on self test (POST). The POST is responsible for the 
following system and diagnostic functions: 

 Performs initial hardware checks, such as determining the amount of memory present 

 Verifies that the devices needed to start an operating system, such as a hard disk, are 

present 

ROM 
Are you Ok? 

I am fine 

Other 
components 

I am Not OK. 
System 
beeps. 
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 Retrieves system configuration settings from nonvolatile complementary metal-oxide 

semiconductor (CMOS) memory, which is located on the motherboard 

The contents of CMOS memory remain even after you shut down the computer. Examples of 

hardware settings stored in CMOS memory include boot order and Plug and Play information. 

After the motherboard POST completes, add-on adapters that have their own firmware (for 
example, video and hard drive controllers) carry out internal diagnostic tests. 

To access and change system and peripheral firmware settings, consult the system 
documentation provided by the manufacturer. 

  
 
 

Virus, Anti-Virus, Vaccines 
 
 Virus is nothing but a program written using one of the computer languages, to cause 
damage to data, the information or the hardware of the computer. . Like a biological virus, a 
computer virus also keeps on spreading. Generally, viruses are memory resident. While in 
memory, it keeps infecting on other program files and keeps on spreading through disks or 
networks.   In other words it is destructive software.  A virus can replicate itself very easily.  
This is because along with the instructions it has for destroying data; it also has instructions for 
copying itself on to the memory of the computer.  It also has instructions to copy itself in any 
floppy disk drive.  It can multiply itself or make several copies of itself. 
 
 
 The most common damage that is done by virus is that it  
 

 Erase data from the hard disk. 
 Increase the file size of command file by several 1000 bytes. 
 Affects the hardware components. 

Types of Viruses 

Different types of viruses are: 

 Boot Sector virus  
 File Virus (EXE type and COM type)  
 Directory Virus  
 Macro Viruses.  

 
Programs that are used for preventing virus are called anti-virus software and programs 

that are used for removing the virus are called vaccines. 
 

http://www.angelfire.com/myband/binusoman/Virus.html
http://www.angelfire.com/myband/binusoman/Virus.html
http://www.angelfire.com/myband/binusoman/Virus.html
http://www.angelfire.com/myband/binusoman/Virus.html
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Antivirus 
 

Antivirus or anti-virus software is used to prevent, detect, and remove malware, including 
but not limited to computer viruses, computer worm, trojan horses, spyware and adware. This 
page talks about the software used for the prevention and removal of such threats, rather than 
computer security implemented by software methods. Some of the Antivirus softwares are 
   

 Avast! Free Antivirus 
 AVG Anti-Virus 
 Avira AntiVir Premium 
 Symantec Norton  
 Trend Micro Internet Security 

Vaccines 

To write a vaccine for a particular virus, we should know how the virus behaves. We can get a 
sequence of virus code (after analyzing the code of virus), a few bytes we call as virus 
signature. So a virus scanner searches for this signature in a file, the presence of which 
indicates that file is infected. After analyzing the virus code, we could know that where it is 
infecting, like at the bottom of the target program, or at the beginning. Then we could delete 
that much number of bytes as the virus length from the file.  

 

Versions of software 
 
 Software is the result of many people putting their heads together to chum out a product 
that will cater to the needs of a wide range of users.  Many mothers are spent writing program, 
testing them correcting them.  After all the programs have been written, tested corrected, the 
software is said to be ready.  This ready-made software is sold in the market to users who range 
from computer professionals, to other professionals who use the computer as a tool.  All these 
users have to be taught how to work the software.  No matter how user friendly the software is, 
there is always the need to refer to some thing that will tell the user how to use the software. 
 
 Ready-made software comes with a user’s manual.  All manuals however speak only 
about the product.   There is no information on the knowledge that may be a pre-request for 
using that software. 
 
 All software keeps getting improvised by the people who develop it.  This happens 
because only extensive use by the users do all the mistakes in the program come to light.  After 
the errors get notified they are rectified and a new version of the software gets released.  For 
example when windows was released it was just called windows.  Then there were different 
versions called windows 3.1, windows 3.11 and Windows 95.  Each release comes with more 
and more improvisations. 
 

http://en.wikipedia.org/wiki/Software
http://en.wikipedia.org/wiki/Malware
http://en.wikipedia.org/wiki/Computer_virus
http://en.wikipedia.org/wiki/Computer_worm
http://en.wikipedia.org/wiki/Trojan_horse_(computing)
http://en.wikipedia.org/wiki/Spyware
http://en.wikipedia.org/wiki/Adware
http://en.wikipedia.org/wiki/Threat_(computer)
http://en.wikipedia.org/wiki/Computer_security
http://en.wikipedia.org/wiki/Avast!
http://en.wikipedia.org/wiki/AVG_(software)
http://en.wikipedia.org/wiki/Avira
http://en.wikipedia.org/wiki/Symantec
http://en.wikipedia.org/wiki/Norton_AntiVirus
http://en.wikipedia.org/wiki/Trend_Micro_Internet_Security
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 A lot of people spend months writing programs to create software.  Software also gets 
copied and distributed in the market illegally and at rates which are one tenth of the original 
price.  This is called software piracy. 

 
Introduction to operating system 
 
 The hardware consists of the Central Processing Unit, Input Unit, Output devices and 
Memory parts of the computer hardware cannot produce any results id there is no interaction 
between any other machines, the computer system also requires a force or an intermediate 
operator interact between the hardware and the user. 
 
 A program is a task given to a computer.  It contains step-by-step instructions to 
perform a simple example of a program is a stepwise procedure to find the average of some 
numbers intermediate force is required which interprets them instructions of the program to the 
hardware data and instructions have to be read and executed to complete a task. 
 
 Software is a collection of programs that gives instructions to the hardware and vice 
versa in user interaction with the hardware and provides different facilities to the user to 
complete them. 
  
 The system software makes the Central Processing unit of the computer coordinate with 
parts of the computer system. 
 

The operating system is responsible for carrying out the following tasks 
 
It loads itself in the memory:-  The process of loading the operating system into the memory 
is known as booting.  Only if it is present in the memory can it allow the user to interact with 
the hardware. 
 
It loads the user program in the memory:- The user may have written some instructions to 
sole the problem of adding two numbers.  These stepwise instructions, called a program, are 
loaded in some part of the memory so that the CPU can access these instructions. 
 
The data required by the program is also loaded in the memory:- The data is entered by the 
user through the input device.  The operating system places this data in the memory.  Each 
location in the memory has a specific address.  The operating system identifies the data entered 
by the user as a memory address.  This memory address is a number.  The operating system 
keeps a track of these memory locations where data and programs have been stored. 
 
Interprets the program instructions one at a time:- The operating system provides 
interpretation of each instruction to the CPU.  The CPU adds the two numbers by reading the 
numbers from the memory and storing the result in some other location.  The user may refer to 
this location with any name like RESULT.  The operating system refers to it as a memory 
location like 8000. 
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Gives instruction to display the result on the screen:- The operating system tells the CPU to 
read the memory location 8000 and display the contents.  The operating system manages the 
resources like memory, input device, output device like the monitor. 
 
 The operating system is also responsible for reading data from the storage devices, 
where a user has stored his data or program.  Just like the operating system keeps track of the 
location in memory where data and programs are loaded, it also keeps track of the location 
where a program is stored in a storage device. 
 

The functions of the operating system as follows 
 

1. It loads itself in the computer’s memory. 
2. It loads user and application programs in the computer’s memory. 
3. It load the data associated with the application programs in the computer’s memory. 
4. It interprets application program instruction one at a time. 
5. It activates the storage devices attached to the computer system in order to transfer the 

data from the computer’s memory to the storage device. 
6. It read data from the storage device and transfers it to the computer’s memory for use 

by the application programs. 
7. It provides the means for the proper use of the resources like memory, input and output 

devices. 
8. It manages the various resources and allocates them to various users as and when 

required. 
9. It coordinates flow of data between various application programs and users. 
10. It allows the user to interact with the hardware to obtain results. 

 
 

Classification of operating systems 
 
 There are many operating system that have been developed to simplify the manner in 
which the user interacts with the computer. Mainly the operating system can be classified as 
follows. 
 

1. Real-Time Operating System 
2. Single- User, Single Task Operating System 
3. Single-User, Multi-Tasking Operating System 
4. Multi-user Operating System. 

 

Real -Time Operating System (RTOS) 
 
 Real-time operating systems are used to control machinery, scientific instruments and 
industrial systems.  An RTOS typically has very little user-interface capability, and no end-user 
utilities.  A very important part of an RTOS is managing the resources of the computer so that 
a particular operation executes in precisely the same amount of time every time it occurs.   
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Single-user Single -Task system 
 
 A system having a single CPU and one set of I/O devices is referred to as a personal 
computer (PC).  Since there is only one job or program that is loaded in memory for execution 
there is only one user at a time of working on the system.  Hence these systems are called 
single user systems.  These machines are also sometimes termed as stand alone machines.  
These are efficient and user-friendly systems.  They increase the working speed and efficiency 
of an organization.  This is possible due to easy operational and interaction facilities provided 
by the operating system. 
 
 MS-DOS (Microsoft Disk Operating System) is one of the popular operating system for 
single user machines like the IBM-OC. 
 

Single-user Multi -Task system 
 
 This is the type of operating system most people use on their desktop and laptop 
computers today.  Windows 98 and the MacOs are both examples of an operating system that 
will let a single user have several programs in operation at the same time.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The input device 

 Keyboard 
 

The USER The Control Unit / The ALU 

THE OPERATING 

User program 

The output device 

Printer/Monitor 

The floppy 
disk The hard disk 

The storage device 

The Central Processing Unit 

App1 App 2 
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Multi-user systems 
 
 As the number of computer system users in the technical and commercial world 
increased, there was a need to develop an operating system, which would manage more than 
one user using the computer system at the same time. 
 
 These users can use either different data or application software/user programs for their 
tasks or the same. 
 
 

The advantages of multi user systems are 
 

1. They are systems that are used by more than one user. 
2. They allow the computer system of one user in interact with the computer system of 

user.  In other words the computers are connected to each other. 
3. The resources available with the computer system can be used by more thane one user. 
4. The system also has the advantages of executing one or more tasks at a time. 

The multiple users can be serviced by one operating system there is no requirement of 
keeping several copies of the data.  Popular multi-user operating systems are UNIX and 
Windows NT. 
 
 

Basic tasks of Operating System 
 

 When the power to a computer is turned on, the first program that runs is usually a set 
of instructions kept in the computer’s read-only memory that examines the system hardware to 
make sure everything is functioning properly.  This Power-On Self Test (POST) checks the 
CPU, memory, and basic input-output systems (BIOS) for errors and stores the result in a 
special memory location.  Once the post has successfully completed, the software loaded in 
ROM will begin to activate the computer’s disk drives.  The bootstrap loader is a small 
program that has a single function.  It loads the operating system into memory and allows it to 
begin operation. 

 

The operating system’s tasks, in the most general sense are 
 

 Processor management 
 Memory and Storage management 
 Device management 
 Application interface  
 User interface. 

 

Basics of MS-DOS 
 
 MS-DOS refers to Microsoft Disk Operating System, which gives all its resources to a 
single user and hence it is known as a single user operating system. 
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 Microsoft DOS is a command line user interface.  MS-DOS  1.0 was released in 1981 
for IBM computers and the latest version of MS-DOS is 6.22, which was released in 1994. 
 
 The commands in the MS-DOS can be categorized as  

1. Internal commands  
2. External commands. 

 
Internal commands are those commands which are readily available for the user after 

the installation of the DOS is over and there is no need for an external agency to help to 
execute this command. 

 
External commands are those which do need the help of an external agency to perform 

the required function.  These external commands can be executed by inserting the floppy disk 
containing these commands into our computer. 
 

List of some Internal commands 
 
Command  Description Function. 
Dir   
Dir/p, Dir/w Directory To list down the entire directory of 

files. 
MD Make Directory To create a directory. 
RD Remove Directory To erase a directory. 
TYPE Type  To read a file. 
REN Rename To change a file name. 
COPY Copy To copy a file from one location to 

another location. 
DEL Delete To delete a file. 
CLS Clear Screen To clear the screen. 
   

 

List of some External commands 
 
Command  Description Function. 
FORMAT Disk Format To format a disk. 
FORMAT/V Disk Format and labeling To format a disk and label 

it. 
LABEL Label the disk To name the disk. 
DISK COPY Disk copy To copy the entire disk 

(inclusive of the hidden 
files). 

CHKDSK Check disk To find out free available 
space of a disk in terms of 
byte. 
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Basics of MS-Windows 
 
 The most popular operating system among the users is MS-WINDOW.  We have 
several versions in windows.  The popular and the latest edition of windows is Windows XP 
professional.  It is really versatile and user friendly and it is used in most offices, business 
concerns, educational institutions, banks and so on.  Now it is used on a LAN based networked 
environment.  It contains new utilities and has improved performance and supports the latest 
hardware technologies.  Almost all sorts of tasks can be performed with windows very easily 
as they used icon based applications.  That is from the desk top, one can operate the computer 
and apply according to their needs. 
 

Advantages of Windows over DOS 
 The following are the advantages of using WINDOWS over DOS. 
 

1. The very important and significant advantage of using WINDOWS is its Graphical 
User Interface (GUI). MS DOS uses command line interface.  In DOS you have to 
remember the commands and type them without mistakes.  A simple spelling 
mistake or missed space will result in an error.  But in windows with its GUI 
display all the information on the screen in a form of ICON.  All you have to do is 
to point and select the icon and thereby select the required application by using the 
mouse. 

2. WINDOWS allows you to use several utilities like calculator, paint, WordPad, 
internet explorer, clipart and so on. 

3. There are a wide variety of other software applications that can be used on 
windows. 

4. WINDOWS allows you to run multiple applications at the same time. 
5. It also allows you to easily switch between the applications and also can transfer 

data between them. 
6. WINDOWS has online help facility to guide you and through which one can find 

information on a topic based on category, index and search using keywords or 
phases. 

7. It has an excellent internet interface.  You can easily access and browse through 
web pages from anywhere on your computer. 

8. It is used to play interactive games using joy stick. 
9. It is used to play music, seeing videos and also run some multimedia applications. 
 

Desktop  and Desktop Icons 
 

Desktop  
When your computer is booted up and ready to use, the screen you see is called the desktop. It 
is the background for all programs and contains the commands needed for accessing those 
programs. As you move the mouse around with your hand, you see the mouse pointer move 
accordingly on the computer desktop. The icons on the desktop correspond to commonly used 
programs found in the computer. These icons are actually shortcuts to the programs themselves 
and double-clicking the icons will launch the programs automatically. 
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Taskbar 
 
All open windows will be accessible via the Taskbar. You can select them by clicking on the 
button that they formed when they were first opened. 
 

 
 
Time and date are found on the right-hand side of the Taskbar and can be changed by double 
clicking on the numbers that display the time.  

 
Icons 
 
Another important graphic feature that you will find on a desktop is an icon. Icons are small 
pictures that are linked to programs. Double-clicking on the icon runs the program or accesses 
the file and right-clicking accesses a menu offering options, actions and properties. Certain 
icons are a permanent fixture on the desktop. The user can put other icons on the desktop that 
will quickly access programs or files - like a shortcut. Icons can be moved around on the 
desktop by clicking and dragging them. 
 
The windows desktop have some common icons are 

 

The My Computer icon will show a listing of the computer’s disk drives, 
network drives, and system files/folders. Local files or folders are found on 
the computer’s drives whereas remote files or folders are found on the 
network drives. Double-clicking on the drive letter will open the contents 
of that drive. 

 

 
The My Documents folder is the default folder where most of the 
Windows XP programs will save your files. 
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Re-aranging icons  
You can move an icon by clicking on it with the mouse and dragging it.  You can re-arrange 
icons by right-clicking on an empty part of the desktop, and choosing ‘Arrange Icons by’, then 
choose an option.  Autoarrange will always put the icons back if they get dragged out of place. 

 
 
Creating a desktop shortcut  
Right click on the desktop, choose New, then Shortcut. Click on the Browse button to choose 
the application/file for which you want the shortcut. After Next you can choose the name for it. 
Finish will create it.  

 

 

The My Network Places icon shows the computer name list which are 
connected to same network. 

 

Recycle Bin  
When you delete a file, Windows XP will place the file into the recycle 
bin (instead of deleting it altogether), this allows you to restore the 
file in case you deleted it by mistake.  
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Alternatively, you can drag an application on to the desktop from the Start menu for 
instance, or you can right click on an application link, choose Send to, then Desktop (create 
shortcut). 
 

Starting Programs 
 
1. Using Start menu 
 
The Start Menu contains shortcuts to the most commonly used programs that are found on your 
computer. It shows the all software programs that have already installed in your computer. 
 
Clicking Start -> Programs -> Accessories -> Calculator will launch the calculator program 
 

 
 
2. Using RUN Command 
 
If you know the name of the program you want to open, go to Start -> Run and type in the 
program’s name. For example, if you want to open the calculator program, go to Start -> Run and 
type in the name calc. Click the OK button. 
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3. Create Shortcut 
 
     Right click on free space on Desktop, select NEW and Select Shortcut  option . Then the 
Create Shortcut dialog box shows. In the dialog  box type the file name with path or click 
Browse button and  select the file from available location and click the Finish button. The new 
icon is created on desktop with file name. Double click the created icon to open the file. 
 
Windows components 
Normally, each window has following components. 

1. Title Bar   shows the Title or name of application programs at left most corner and 
Control buttons which are used to maximize or minimize, restore and close operations. 

2. Menu Bar  shows the menu commands that are used to do users work for the 
application programs. 

3. Tool Bar   shows icons that is used to run commands which user click the icons 
 
Every window  have a series of buttons on the top right corner of the Title Bar to manage the 
window size. 

 -Close Button – Close the current application window 
 - Restore Button – Minimize the window and store in the Task Bar 
 - Maximize Button – Switch over the window size from smaller size into full screen 

size or maxmimum size. 

      - Minimize Button – Switch over the window from full size into smaller window size 
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Browsing and Managing Windows Explorer 
 
Opening Windows Explorer  
 

Windows Explorer is part of all Windows operating systems (Windows 95, 98, 2000, Me, XP 
and Vista) and is an easy way to manipulate files and view the contents of your computer. 
Using Windows Explorer you can examine files, create folders and organize files within 
folders, and copy and move files between different locations. These abilities will enable you to 
perform the basic housekeeping tasks needed to organize your work on a PC running any 
Windows Operating system (Windows 95, 98, Me, 2000, XP, or Vista). 
 
To Open Windows Explorer  
 

There are a few ways to open Windows Explorer, here are 3 different methods:  
 
Method 1 - Click on the START button, hover your mouse over the All Programs  
and then hover over Accessories, finally click on Windows Explorer.  
 
Method 2 - click the START button, click run, type explorer into the box and press 
enter.  
 
Method 3 - open My Computer and click on the Folders button on the toolbar. 

 
Navigating through your drives and folders  
 
When you have opened Windows Explorer (or opened my computer and then clicked the 
folders button) you will see something similar to that shown in fig 1.1 below: 

 
 
You can see Windows Explorer is split into two parts. The left hand side which is called the 
folders list (A in fig 1.1), and the right hand side (B in fig 1.1) which is where you will be 
managing your files and folders.  
 
First let's concentrate on the folders list, you may have noticed the small plus sign (+) 
next to some of the icons, these indicate that the drive/folder has more folders inside it.  
 
The file system of your PC is organised in a hierarchical way, below is an example:  
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The Disk or Device is the upper hierarchical level and is 
known as the root.  
 
Notice how the folders are organised, this type of structure can 
facilitate a very organised PC!  

 
In the following example, the disk or device is Local Disk (C:).  

 
 
In fig 1.3 above we have navigated to the pc course folder on Local Disk (C:).  
 

1. First we clicked on the small arrow next to the My Computer icon  

2. then clicking the arrow next to Local Disk (C:)  

3. and finally left clicking on the pc courses folder in the left pane.  

Now that we have navigated to it, we could make some changes to our pc courses folder. 
 
Creating a new folder or folders  
 
Open Windows Explorer, navigate to the drive or folder in which you want to create your 
new folder. For our example we are going to create a new folder in our pc courses folder.  
 
The steps are:  
 

1. right click anywhere in the white space (fig 1.1) and hover the mouse over new  

2. then click on folder from the sub-menu that appears as shown in fig 1.2 below.  
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You will then be prompted to name the folder (as shown in fig 1.3 on 
the left), simply type in the name and then press the enter (return) 
key. We are going to name our folder example C.  
 
Try and be as descriptive as you can when naming folders, and avoid 
using any punctuation symbols in the names.  

Copying, Deleting, and Renaming Files and Folders  
 
All of these tasks are straight forward and can be achieved using the same method.  
 
First, navigate to the folder where the file or folder is stored, then right click on the 
file/folder of interest. You will be presented with a menu similar to that shown in fig 1.4.  
 

 

Your menu may vary, we have pointed out 3 options:  

1. copy - clicking on this option will copy the file or 
folder into (the clipboard) memory. You can then 
navigate to the folder where you want to copy the 
file to, right click (as if making a new folder) in the 
right hand pane and select paste from the menu 
that appears.  

2. delete - this option will delete the file or folder 
(send it to the recycle bin), Windows XP will 
prompt you for confirmation first.  

3. rename - this option allows you to rename the file 
or folder, simply type in the new name and press 
the enter (return) key.  
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Searching Files or Folders 
 
 To search for the file that was just restored, Click the Start Menu button, and select Search  
 then the search window will be open. 

 
 
There are various ways to search for files and folders. You are able to search by file name or 
words found in the file you are looking for. You can search specific areas of your hard drive or 
for files that were created or modified on a certain date. Test some different ways of searching 
to see which one works best for you. 

  
 
Deleting a File or Folder 
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  First we select the single file or Multiple files or  folder that we want to delete. Delete 
operation is performed in three ways. 

1. From the Menu Bar, select File -> Delete  
2. Press Delete button from Key board 
3. Open Windows Explorer,  Drag the file from its location and Drop in Recycle Bin 

folder 

 
 
 

 Click the Yes button.  
 

Task bar Settings 

At any given time, you might have several programs, folders, and documents open on your 
desktop. The short name for "anything that's currently open on your desktop" is task. That is, 
we can refer to each open item on your desktop -- no matter what that item is, as a "task", short 
for "task-in-progress". The Windows taskbar, which is roughly centered across the bottom of 
your screen, as in Figure 1.   
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Figure 1 

Here are some things you can do with the taskbar along those lines: 

 You can also click a task's taskbar button to make it invisible the application window 
(so it's not taking up any space on the desktop), then click that same button again to 
make it visible again.  

 You can also close any open task (thereby removing it from the desktop and putting it 
back in the filing cabinet) by right-clicking its taskbar button and choosing Close.  

Setting Taskbar Options 

Like everything else in Windows XP, you can customize the taskbar to your liking. To do so, 
right-click the Start button and choose Properties. In the Taskbar and Start Menu Properties 
dialog box that opens, click on the Taskbar tab. The options shown in Figure 3 appear. Your 
options are summarized below: 

 Figure 3 
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 Lock the taskbar: If selected, hides all sizing handles on the taskbar so you can't 
accidentally move or resize it (as discussed below).  

 Auto-hide the taskbar: If you select this option, the taskbar will be hidden most of the 
time so as to not take up any space on the screen. To make it visible, move the mouse 
pointer to the very bottom of your screen.  

 Keep the taskbar on top of other windows: If selected, makes sure the taskbar is 
visible at all times, even when large maximized program windows are covering the rest 
of the screen.  

 Group similar taskbar buttons: If selected, allows multiple taskbar buttons to 
collapse into a single button so the buttons don't become too small to see on the taskbar.  

 Show Quick Launch: If selected, displayed the optional Quick Launch toolbar to the 
right of the Start button.  

Moving and Sizing the Taskbar 

Windows XP is very flexible. You can size, color, and position anything to your liking. But 
you can only move and size things on the taskbar when the taskbar is unlocked. But just so you 
know, when the taskbar is unlocked, you can change its height as follows: 

1. Move the mouse pointer to the thin bar that appears along the top strip of the taskbar, 
until the mouse pointer turns to a two-headed arrow. 

2. Hold down the left mouse button and drag that top edge up or down until the taskbar is 
the width you want, then release the mouse button. 
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UNIT – III - Introduction to Internet 
Network 
 
 If two or more computers are said to be interconnected then they are able to 
exchange information and resources like printer with each other. The three types of 
Networks are  
 
1. Local Area Network (LAN) - Computers are connected with in a building or campus up 
to a few kilometers.100 m for buildings, 1 km for campus, 10 m for room. 
2. Metropolitan Area Network (MAN) - A network contained in the distance of a city or 
roughly 30 miles. 
3. Wide Area Network (WAN) - Network with a large geographical area like a country or 
continent. 
 
What is Internet? 

The internet is a world wide collection of computer networks connecting academic 
governmental, commercial and organizational sites.  It provides access to communication 
services and Information resources to million of users around the globe.  One of the 
important facts about the internet is that nobody really owns it.  It is global collection of 
networks.  The internet society is a non profit group, the formation of policies and protocol 
that define how we use and interact with the internet.  Every computer that is connected to 
the internet is part of a network even the one in your home.   
 
 Internet is the world’s largest computer network, the network of networks, scattered 
all over the world 

 
History of Internet 
 
 In 1960, Advanced Research Project Agency(ARPA) introduced the ARPAnet 
which is the first concept of Internet.  ARPAnet built a mega-network in the United States 
connecting Department of Defense, the University of California at Los Angles (UCLA), the 
Stanford Research Institute (SRI), the University of California, at Santa Barbara (USCB) 
and the University of Utha. 
.  
 Another factor in the rapid growth of this technology was the inclusion of the 
TCP/IP protocols in the Berkeley version of UNIX.  TCP/IP protocols gained wide usage, 
and more networks wee created with them.  These networks began to connect to each other.  
There was originally only one, the ARPAnet.  Soon there were many separate networks.  
Eventually all these Individual interconnected TCP/IP networks were collectively referred 
to as the Internet, or more simply the net.                                                                                                                             
 
The following components are needed for internet connection. 
 1. Personal Computer 
 2. Modem or ISDN – Modem (Modulation and Demodulation) is used to convert digital 
information into analog signals which carried by ordinary telephone line and also convert 
the analog signal into digital signal which send back to the computer. ISDN (Integrated 
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Services Digital Network) is carries digital signal from one computer to another computer 
through special telephone wires. 
3. Telephone connection -  Get a telephone connection from telephone agents. 
4. ISP (Internet Service Provider) – Purchase internet account package from ISP and install 
in your computer. It gives user name and password to enter into the internet.  
 
How to enter into Internet? 
 
 After configuring the internet along with the pc, you can see the Icon on the desk 
top with the ISP’s name given by the user. By clicking that ISP’s name Icon you will get 
window contains username and password.  Dial then click the dial button and wait for some 
time.  The username and password verified and if they are correct and then internet 
connectivity will be achieved. Then you can open the browser and start your browsing in 
the internet. 
 
Browser  
 
 A browser is a software program that allow user to access and navigate the World 
Wide Web.  The process of accessing the web site through the software is called browsing. 
 
How to browse the website 
 
 After achieving internet connectivity double click the Internet Explore to open it. 
 
 If you want to browse a web site, that website’s address has to be typed in the 
address box. (Uniform Resource Locator). Eg., www.annamalaiuniversity.ac.in 
 
 After typing the address then press the enter key, in few second your will see your 
specified web site. 
 

Client/ Server Basics 
 
A client accesses the Internet to obtain desired information. The server is responsible for 
performing the tasks as requested by the client. 

A server is a piece of hardware that receives, processes, and replies to a query. A server has 
the capability to handle multiple connections concurrently and from many different sources 
or clients. Server hardware traditionally has been a minicomputer such as a Sun or a Cray, 
or a high-end IBM or DEC computer. With the new Pentium and power-PC processor, 
however, more PCs are being used as servers for limited uses such as a Web or a mail 
server, or even an FTP file server. For Telnet or database applications, however, more 
powerful servers are needed. On the other hand, if a large corporation wanted to maintain 
an up-to-the-minute nationwide inventory supply, a more powerful computer likely would 
be required. 

http://www.annamalaiuniversity.ac.in/
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You can have multiple software servers on one computer. In a typical intranet, an 
organization will want a mail server to process and deliver e-mail, an FTP server to manage 
file transfers, a Web server to host and serve World Wide Web documents, and possibly a 
database server to store and process data. 

A client is a computer or software application that helps a user form and send a query and 
then displays the results of the queried information for the user. Practically any computer 
can be a client  

A mail client does much the same. There is a standard mail protocol over the Internet, but 
dozens of clients take the information. Though your message may be entered in several 
ways, each client will put it in the correct format to transmit it over the Internet. 

Examples of clients are Eudora and Outlook Express for mail, Fetch or CuteFTP for file 
transfer, and Netscape or Internet Explorer for browsing the World Wide Web. 

Like automated teller machines (ATMs), client/server applications are based on 
transactions. The client sends a request to the server, similar to a customer sending a 
request to an ATM. Just as the outcome of the ATM transaction depends on what type of 
information the customer gives the ATM when prompted, so does the outcome of a client 
request for information from a server depend on the information given to the server.  

The client sends a request to the server with the following information:  

 Address for the server (Where do I ask for this information?)  
 The request (What information do you want?)  
 The return address for the information (Where do I send the information?)  

There must be a common protocol that both the client and the server speak to communicate 
with one another. On the Internet that protocol is TCP/IP. The server does most of the work 
in the relationship: It waits for requests, processes them, and then sends the client the 
information requested.  

E-Mail 

E-mail (electronic mail) is the exchange of computer-stored messages by 
telecommunication. E-mail messages are usually encoded in ASCII text. However, you can 
also send non-text files, such as graphic images and sound files, as attachments sent in 
binary streams. Internet email can be sent to anyone in the world who has an Internet email 
address. 

Email has both similarities and differences with more conventional postal services. First, 
messages are posted electronically to individuals at specific addresses much like 
conventional mail. The address denotes the computer that the individual employs as a mail 
server. A mail server is like a local post office: it is a computer that sends and receives 
electronic mail for a specific network. Like regular mail, when messages are delivered, the 
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user may read them at his or her convenience and like postal letters, email may be saved or 
discarded. 

 

Unlike conventional mail, email is much faster. This means that multiple copies of a given 
message can be sent to different parties automatically with no more effort than indicating 
the distribution list of addresses.  

Replies to email can be automatic too. Most mail programs allow the user to reply to the 
sender and include part or the entire original message. A major difference between email 
and conventional mail is that while postal letters are not entirely secure, email is even less 
secure.  

Email addresses are similar to regular mail in that the addresses are unique. Email 
has a unique post office --- that is an email server. Each email server must have a 
unique name. When you send your email the last part of the address after the @ is the 
server address (or post office). 

  Ex.  mani_1788@yahoo.co.in, alvernja@alverno.edu 

Parts to an email 

 header - It contains Date line, From line, To line, Subject line, CC line and BCC 
line. 

Date :  To display message sending date and time. 
From : It shows the senders mail address 
To : It shows the recipients address 
Subject : It shows title  or  purpose of the message content. 
CC:  (Carbon Copy)  field allows you to send the same message to multiple  

 recipients. When you send a Cc: message, all recipients are aware of who  
 received copies of the message. Cc: stands for carbon copy and is a holdover from  
 the days when letters were typed with carbon paper between the pages to create  
 identical letters for multiple recipients.  

mailto:mani_1788@yahoo.co.in
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 BCC: (Blind Carbon Copy) field allows you to send an identical message to  

 multiple recipients, however, those recipients whose addresses appear in the BCC:  

 field cannot be seen by the other recipients.. 

 message body, where you write your message  
 signature, which identifies the sender. This part is optional and must be set up 

inside of your email software  

Date: Mon, 6 Aug 2001 10:04:11 –0500 
From: alvernja@alverno.edu  
To: anthonsb@alverno.edu 
Subject: When can we meet? 

   

When can we get together to work on our project? 
I am available any time this week after 5:00 PM. 
But I do have some other appointments next 
week. I would like to meet before we have our 
next class so email me and let me know what 
would work for you. 
Thanks! 

 

Jane A. Alverno  
Student, Alverno College  

 

SMTP: SMTP is short for Simple Mail Transfer Protocol. SMTP can only be used to send 
email messages.  

POP: POP stands for Post Office Protocol and is a protocol that is used to receive email. 
The most recent version of POP is called POP3. POP3 is a client-server protocol which 
means that your email messages are stored on your server and need to be downloaded to 
your computer hard drive in order to be read. An email client such as Netscape, Outlook 
Express, AOL, or Eudora is used to download the emails onto your computer. 

Telnet 
 
Telnet allows log-in access to another computer on the Internet.   
 
 Telnet is a protocol or set of rules that enables one computer to connect to another 
computer.  It allows you to remotely log into a computer system and use your local screen 
and keyboard as terminals.  The user’s computers, which imitates the connection is referred 
to as the local computer and the machine being connected to which accepts the connection 
is referred to as the remote or host computer.  The remote computer can be physically 
located in the next room, the next town, or in another country.  Once connected, the user’s 

mailto:alvernja@alverno.edu
mailto:anthonsb@alverno.edu
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computer emulates the remote computer.  When the user types in commands, they are 
executed in the remote computer.  The user’s monitor displays what is taking place on the 
remote computer during the telnet session.  Telnet also operates on the client/server 
principle.  The local computer uses a telnet client program to establish the connection and 
display data on the local computer’s monitor.  The remote or host computer uses a telnet 
server program to accept the connection and send response to requests for information back 
to the local computer. 

Library of Congress telnet://locis.loc.gov Search for materials available at the United 
States Library of Congress. No log in name or password is required.  

PEN pages telnet://world@psupen.psu.edu . Search and retrieve information from 
agricultural, health, teaching, and other databases. This service is provided by the College 
of Agriculture of the Pennsylvania State University and the Pennsylvania Department of 
Education. You type in the word world when you see the prompt Username:  

Weather Forecasts telnet://madlab.sprl.umich.edu:3000 Check weather forecasts and 
other weather related information.  

Archie  

Archie was the first search engine ever invented, designed to index FTP archives, allowing 
people to find specific files. The original implementation was written in 1990 by Alan 
Emtage, Bill Heelan, and Peter J. Deutsch, then students at McGill University in Montreal. 
 
The earliest versions of archie simply contacted a list of FTP archives on a regular basis 
(contacting each roughly once a month, so as not to waste too much resource on the remote 
servers) and requested a listing. These listings were stored in local files to be searched 
using the UNIX grep command. Later, more efficient front- and back-ends were developed, 
and the system spread from a local tool, to a network-wide resource, to a popular service 
available from multiple sites around the Internet. Such archie servers could be accessed in 
multiple ways: using a local client (such as archie or xarchie); telneting to a server directly; 
sending queries by electronic mail; and later via World Wide Web interfaces. 

FTP 

File Transfer Protocol (FTP) is a standard Internet protocol for transmitting files between 
computers on the Internet. FTP is an application protocol that uses the Internet's TCP/IP 
protocols. FTP is commonly used to transfer Web page files from their creator to the 
computer that acts as their server for everyone on the Internet. It's also commonly used to 
download programs and other files to your computer from other servers. 

Files that can be transferred are stored on computer called FTP servers.  To access these 
files an FTP client program is used.  This is an interface that allows the user to locate the 
files to be transferred and initiate the transfer process.Your Web browser can also make 
FTP requests to download programs you select from a Web page.  

telnet://locis.loc.gov/
telnet://world@psupen.psu.edu%20pen%20pages/
telnet://madlab.sprl.umich.edu:3000/
http://searchnetworking.techtarget.com/sDefinition/0,,sid7_gci214173,00.html


 7

Using FTP, you can also update (delete, rename, move, and copy) files at a server. You 
need to logon to an FTP server. However, publicly available files are easily accessed using 
anonymous FTP. 
 
The basic steps to use FTP are 

1. Connect to the FTP server. 
2. Navigate the file structure to find the file you want. 
3. Transfer the file. 

 

Gopher 

The Gopher protocol  is a TCP/IP application layer protocol designed for distributing, 
searching, and retrieving documents over the Internet. Strongly oriented towards a menu-
document design, the Gopher protocol was a predecessor of (and later, an alternative to) the 
World Wide Web. 

A protocol for searching file names and resources on the Internet that presents hierarchical 
menus to the user.  

 

http://en.wikipedia.org/wiki/Wikipedia:IPA_for_English
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From about 1992 through 1996, Gopher was an Internet application in which 
hierarchically-organized text files could be brought from servers all over the world to a 
viewer on your computer. Especially in universities, Gopher was a step toward the World 
Wide Web's Hypertext Transfer Protocol (HTTP), which effectively replaced it within a 
short time. Gopher was developed at the University of Minnesota, whose sports teams are 
called "the Golden Gophers." 

Although most Gopher browsers and files are text-based, Gopher browsers, notably 
HyperGopher, were developed that displayed graphic images (GIF and JPEG files) that 
were included in Gopher file directories. Two tools for searching Gopher file hierarchies 
were Veronica and Jughead. 

Veronica  
 
A program that searches the Internet for specific resources by description, not just file 
name. Unlike most search engines, Veronica searches for keywords only in gopher server 
menu titles, and doesn't look through out the entire text of documents. When searching with 
Veronica, you can use the logical operators AND, NOT, and OR to help narrow your 
search. Also, typing an asterisk (*) at the end of a word will match anything starting with 
that word. 

Jughead  

 Jughead was a tool for searching the information on gopher sites for particular subjects. 
 
WAIS (Wide Area Information Server) 
 
WAIS Stands for "Wide Area Information Server." This is a program that can index 
enormous amounts of information and make it searchable across large networks (including 
the Internet). People can search the WAIS index and it will return results by relevance.  
 
A WAIS client program enables the user’s computer to contact a WAIS server, submit a 
search query and receive a response to that query.  WAIS searches the content of database 
files. 
 
 
 
 
 
 
 
 
 
 
 
 

User sends Query to 
server & read the results Server processes the Query 

and sends back the results 

Query 

Results 

Client WAIS 
Server 

http://whatis.techtarget.com/definition/0,,sid9_gci212427,00.html
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WWW (World Wide Web) 
 
The World Wide Web is distributed system of interlinked web pages which are stored in 
different machines called web servers.  it is a client-server application system which 
transfers text, graphics and sound files through the Hyper Text Transfer Protocol (HTTP). 
These files called pages or web pages contain information or a piece of pages and links to 
resources throughout the Internet.  The collection of web pages is known as a website.  
These files represent text documents, pictures, video, sound, programs, interactive 
environment and other useful details.   
 
The Hypertext markup language (HTML) allows a file co contain links to related files.  
Such a link also called hyperlink contains the information necessary to locate the related 
files on the internet.  When you connect to the Internet and use a web browser, you can 
access any kind of information and from any part of the world where you are located to 
make finding things on the web easier, every web page has an address.  The page address is 
called and URL (Uniform Resource Locater) and works just like a street address.  It tells 
your web browser where to look for the page you want to see. The WWW clients are called 
Web Browsers.  
 
 
Eg:- 
www.yahoo.com 
www.sify.com 
 

Fundamentals of HTML  
 
What is HTML 

HTML is a language for describing web pages. 

 HTML stands for Hyper Text Markup Language 
 HTML is not a programming language, it is a markup language 
 A markup language is a set of markup tags which are surrounded by angle 

brackets like <html>.HTML tags normally come in pairs like <b> and </b> 
 HTML uses markup tags to describe web pages  

HTML gives authors the means to: 
 Publish online documents with headings, text, tables, lists, photos, etc. 
 Retrieve online information via hypertext links, at the click of a button. 
 Design forms for conducting transactions with remote services, for use in searching 

for information, making reservations, ordering products, etc. 
 Include spreadsheets, video clips, sound clips, and other applications directly in 

their documents. 
 
 

http://www.yahoo.com/
http://www.sify.com/
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Structure of an HTML File 

The most important tags are <html> and </html> - the entire document is contained within 
these two tags. The instruction here is simply "This is an HTML document". HTML 
comprises two major parts that give a document a well-structured look. They are:  

1- Head  : The Head contains the title of the document and the heading - which is the 
heading of that particular page in the document. The head section start with 
tag<head> and end with </head>. 
 

2- Body : The Body contains the entire content of the document. The body section start 
with tag <body> and end with </body>. 

 
You can create such a document using any text editor - even a very simple one like 
Windows Notepad. After finishing of the HTML codes, we can save the file with extension 
“.html”. To view an HTML document, you must use a browser (or similar software). The 
browser opens the HTML document in the background and "decodes" it before showing it 
to you. (ex. Home.html). 
 
Example code for  home.html 
 
<html> 

<head> 
          <title> Home Page </title> 
</head> 
<body> 
         This is my first homepage. <b>This text is bold</b> 
 

</body> 
</html> 
 
Output 
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TCP/IP 
 
 TCP/IP stands for Transmission Control Protocol / Internet Protocol.  TCP/IP is 
actually a collection of protocols or rules that govern the way data travels from one 
machine to another across networks.  The internet is based in TCP/IP. TCP/IP has  major 
components. 
 
TCP 

1. Breaks data up into packets that the network can handle efficiently. 
2. Each packet is composed with header and footer. 
3. Verifies at the receiving end whether all the packets have arrived at their 

destination. 
4. Reassembles the data. 

 
IP 

1. Envelopes and address the data 
2. Enables the network to read the envelope and forward the data to its destination. 
3. Defines how much data can fit in a single “envelope” ( a Packet). 
4.  

 

E-commerce 
 

Electronic commerce (commonly entitled as E-commerce) in its simplest interpretation is 
a new way of doing business by buying and selling services or products, that opens big 
perspectives in the market for any type of businesses. Electronic commerce can be between 
two businesses transmitting funds, goods, services and/or data or between a business and a 
customer. 

 

Simply tells E-Commerce is doing business using communication networks like internet, 
mobile network etc. 
 

A number of different types of businesses are covered by this term: starting from retail sites 
which allows consumers to exchange goods and services over the Internet with no barriers 
of time or distance to business exchanges between corporations. 

 

E-commerce also includes such notions as: E-Marketing, E-Trade, E-Banking, E-Cash, E-
Insurance, Electronic Data Interchange (EDI) and Electronic Funds Transfer (EFT). 
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ADVANTAGES OF ECOMMERCE 

 

 Faster buying/selling procedure, as well as easy to find products. 
 Buying/selling 24/7. 
 More reach to customers, there is no theoretical geographic limitations. 
 Low operational costs and better quality of services. 
 No need of physical company set-ups.  
 Easy to start and manage a business. 
 Customers can easily select products from different providers without moving       

around physically. 

 

DISADVANTAGES OF ECOMMERCE 

 Any one, good or bad, can easily start a business. And there are many bad sites 
which eat up customers’ money.  

 There is no guarantee of product quality. 
 Mechanical failures can cause unpredictable effects on the total processes. 
 As there is minimum chance of direct customer to company interactions, customer 

loyalty is always on a check. 
 There are many hackers who look for opportunities, and thus an ecommerce site, 

service, payment gateways, all are always prone to attack. 
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UNIT – IV - HTML 
 
What is HTML 
 
 To publish information for global distribution, one needs a universally understood 
language, a kind of publishing mother tongue that all computers may potentially 
understand.  The publishing language used by the www is HTML. 
 
HTML gives authors the means to: 

 Publish online documents with headings, text, tables, lists, photos, etc. 
 Retrieve online information via hypertext links, at the click of a button. 
 Design forms for conducting transactions with remote services, for use in 

searching for information, making reservations, ordering products, etc. 
 Include spreadsheets, video clips, sound clips, and other applications directly in 

their documents. 
 
HTML files are nothing more than simple text files, so to start writing in HTML, you 
need nothing more than a simple text editor. Notepad is a common text editor (on 
Windows this is usually found under the Programs > Accessories menu). Type html 
codes and save the file as "myfirstpage.html". 
 
To look at HTML files, they don't even need to be on the web. Open a web browser such 
as Firefox or Internet Explorer and in the address bar, where you usually type web 
addresses, type in the location of the file you just saved (for example, 
"c:\html\myfirstpage.html") and hit return. Alternatively, go to the File menu of the 
browser, select Open, and browse for the file. 
 
Structure of a HTML page 
 
 <HTML> 
  <HEAD> 
   <TITLE> name of the document </TITLE> 
  </HEAD> 
  <BODY> 
   …………..page content …………….. 
   …………..page content……………… 
   …………..page content……………… 
  </BODY> 
 </HTML> 
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HTML tags 
 
1. <HTML> tag 
 
The first page structure in every HTML page is the <HTML> tag.  It indicates that the 
content of this file is in the HTML language.  All the text and HTML comments in a 
HTML page should go within the beginning and ending HTML tags. 
 
2. <HEAD> tag 
 
The <HEAD> tag specifies the line within the beginning and ending points of the tag are 
the prologue to the rest of the file.  Generally, only a few tags go into the <HEAD> 
portion of the page. 
 
3. <BODY>..</BODY> tag 
 
The remainder of the HTML page, including all the text and other content is enclosed 
within a <BODY> tag.  
 
4. <TITLE>...</TITLE> tag 
   The <TITLE> tag is used to show title of document in the title bar of the web browser. 
 
5. <H> tag 
   The header tag <H> is used to display the text in different font size. It has six types 
     

<H1>...</H1> - Largest heading size.    ex.  Heading1 

<H2>...</H2> - Large heading size.  ex.  Heading 2 

<H3>...</H3> - Medium-big heading size.  ex.  Heading 3 

<H4>...</H4> - Medium-small heading size. ex.  Heading 4 
<H5>...</H5> - Small heading size. ex.  Heading 5 
<H6>...</H6> - Smalles heading size. ex.  Heading 6 

 
6. <P>…</P> tag 
  The Paragraph tag <P> is used display the in paragraph format and also align the text in 
left, right, center and Justify format. 
 
7. <OL>...</OL> tag 
  This tag is used to show list of items in ordered format. Each item is covered with 
<LI>..</LI> tag. 
    Example:       
          <OL> 
           <LI> red </LI> 
           <LI> green </LI> 
           <LI> blue </LI> 
        </OL> 
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Output 
   1.red 

2.blue 
3.green 

 
7. <UL>...</UL> tag 
  This tag is used to show list of items in unordered format. Each item is covered with 
<LI>..</LI> tag. 
    Example:       
          <UL> 
           <LI> red </LI> 
           <LI> green </LI> 
           <LI> blue </LI> 
        </UL> 
     
Output: 

 red  
 green  
 blue  

8. <B>...</B> tag 
   This is used to display text in bold face. 
 
     <B> bold</B> 
    Output: 
            bold 
 
9. <I>...</I> tag 
   This is used to display text in Italic style. 
 
     <I> Italic </I> 
    Output: 
            Italic 
 
10. <HR> tag 
     This used to draw single line. The <HR> is not need to closing tag </HR> 
       <HR> 
   Output: 
       ____________________________________________________________________ 
 
11. <BR> tag 
      This is used to break line in a paragraph. 
 
12. <IMG> tag 
      This is used to include the image to html page with different size. 
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  Example : <IMG src=“c:\bird.jpg”> 
  
13. <A> … </A> tag 
      This is used to create a hyper link for another page or image or file etc. The linked 
words are displayed in blue color with underlined. User click linking word then we can 
move to the linked page. 
 
  Example: <A href=“c:\main.html”> main </A> 
 
  Output :   main 
 
14. <Table>… </Table> tag 
      This tag is used to display items in tabular format with different color. 
15. <Tr>…</Tr> tag 
       It is used to create new row in a table. It is used inside the <Table> tag. 
16. <Td>…<Td> tag 
      It is used to display individual data item in a single row. It is used inside the <Tr> tag. 
 
Ex : 
   <table border=1> 
     <tr> 

       <td>name</td>  <td> marks(100) </td> 
 </tr> 

    <tr> 
      <td>Mani</td>  <td> 95</td> 
 </tr>  
 <tr> 

           <td>sureh</td>  <td> 85</td> 
 </tr>  

      </table> 
 
Output : 

name marks(100) 

Mani 95 

sureh 85 

 
Simple HTML page 
 
 <HTML> 
  <HEAD> 
   <TITLE> MY FIRST WEB PAGE </TITLE> 
  </HEAD> 
  <BODY> 
   <UL> 
   <L1> SOFTWARE 
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   <OL> 
    <L1> COMPUTER CONCEPTS 
    <L1> MS-WORD 
    <L1> MS -EXCEL 
    <L1> MS-POWERPOINT 
    <L1> MS-ACCESS 
   </OL> 
   <L1> HARDWARE 
   <OL> 
   <LI> CPU 
   <LI> INPUT DEVICE 
   <LI> OUTPUT DEVICE 
   </OL> 
   </UL> 
  </BODY 
 </HTML> 
 
The out put for the above HTML program is as follows 
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What is a website? 

A website is an address (location/server) on the World Wide Web that contains your web 
pages and can be accessed by anyone on the internet.  Each website is identified by 
unique name that is called Uniform Resource Locator (URL). Example www.yahoo.com. 
Web page is a document that contains text, image, sounds, videos and links to other 
pages. 

Making a website is easy. Making a good website is not so easy. There are many things 
you have to consider if you want to make a successful website, no matter if it is a 
commercial or personal site. Web site creation is divided into four steps 

1. Planning a new website 
2. Design and build web pages 
3. Upload web pages to web server (web hosting) 
4. Maintaining the web site. 

 

1. Planning a website 

You will need to create a development and management plan for the site.  you can hold a 
meeting with your group members or customers and discuss about the following contents. 

1. Purpose of new website 
2. Naming of new website. 
3. What type of information and images are included 
4. Selection of good Template  
5. How many links are added which  is used to go other related pages  

2. Designing a website 

First, you can start to design home page which is the starting page or first page of every 
website and also includes links for the web pages. 

http://www.yahoo.com/
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You can create your web pages using software like Macromedia Dreamweaver, Microsoft 
Front Page, etc. A good website contains the following 

1. Good template design. 
2. Align text and images in a attractive manner 
3. Invisible and meaningful menu names 
4. Choose attractive color and text size 
5. Including compatible image size causes very fast loading in web browser 
6. Web pages are run in all web browsers. 
7. Easily understandable headings 
8. Include contact details. 

3. Web Hosting 
After successfully building of website, the next step is hosting your site. For hosting your 
web site, you can communicate some web host company. The company allocate web 
spaces to hold your site. You can pay amount to the company for yearly. After hosting, 
the new site is available in internet and everyone to access. 
 
4. Maintaining the web site 
It is a big process.  You can maintain your site by daily or weekly or monthly depends the 
type of website. 
 

Issues Involved in Web site management 

1. Browser Compatibility: 

     Your website is run on all web browsers. That means you can create a script codes of 
website are executed by all browsers. 

2.  Fast Loading web pages: 

     When the visitor opens your web site, it will be opened with in 8 seconds. Otherwise 
visitors are jumped to other quickly web sites. So, your web pages contain small images 
and needful links.  
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3. Keep content up-to-date: 

    Depends upon the type of web site, you can change content of page every minute or 
daily or weekly or monthly. For example, a News website changes its content every 
minute to attract the visitors. 

4. Spot errors  

   If any error occurred in your website, you can find and rectify it. For example, a page 
cannot be loaded from the link. Then you can check the link and correct it. 

5. Feed back monitoring 

   Every website monitoring their visitors and get some useful ideas from them through 
email or phone. For a good website maintenance, you can analyze and implement the 
visitor’s suggestion in your web pages. 

6. Performance Monitoring 

    You can calculate how many visitors accessing your website per day. Because, a lot of 
websites are available. For a good site, numbers of visitors are increased day by day. That 
is success of creating a website. 

7. Security Problem 

   Your website is a transactional website. Your customer can transfer confidential data 
through web. It is big problem to identify your customer and verify it data is correct or 
wrong. Hackers and Hijackers are breaking your security of website and stolen 
customer’s details and misused. 

  Hacker is person to enter into transactional site and changing the correct data before 
reached to the web server. At the result, No transaction is taken. 

 Hijacker is person to enter into transactional site and get a copy of data and misused. 

8. Font Problem 

    Your web page contains good font size and attractive font color. You can apply 
different font colors for the ordinary text and linking words. You can choose contrast 
colors for background and text. If your page contain new font, you give instruction to the 
user download and install. Then only the user may read the entire page. Ex: Tamil font. 

9. Virus Threat 

   You can maintain your web sites without affecting from virus. Virus is spread through 
internet. If your website is affected from virus, no visitor is to open your web site because 



 9

of visitor’s computer is also affected. The virus may delete the contents of a website from 
web server. 

10. User Problem 

   Your site contains meaningful text, images and links.  For a new user visiting your web 
sites, new user easily understand your sites and what are links are available. 

Addressing  
 

What is a domain name? 
A domain name is a unique name that identifies a website or computer on the Internet. 
Although you can identify a computer by its IP address — for example, 192.168.1.50 — 
numbers are not very easy for people to read or remember. This is why domain names are 
useful — they serve as "nicknames" for websites and computers. A domain name points 
to an IP address, and you can then use the domain name, rather than the IP address, to 
access the website or computer. 

 Example : google.com, yahoo.com, annamalaiuniversity.ac.in , tn.gov.in 
 

Finding a free domain name 
Now that you know how domain names work, your next step is to find a free name that 
you can use for your site. This is easier said than done, because millions of common 
names have already been taken! For advice and tips on choosing a good domain name for 
your site.  
.com domains are the most popular, and the most widely registered. So to increase your 
chance of finding a free domain name, consider registering your domain under a different 
category instead, such as .net, .org, or .info. It can also be a good idea to register a 
country-specific domain — such as example.co.uk — if your business/site is catering 
specifically to that country. The database of registered domain names is known as the 
WHOIS database. You can search this database in a couple of ways to see if the domain 
you want to use is free: 

 
Choose a domain name that's easy to use 
It helps to have a domain name that is easy for people to: 

 remember 
 pronounce, and 
 spell. 

This is especially important if you plan to market your website offline (in a flyer or 
magazine, for example). An easy-to-pronounce name also helps with word-of-mouth 
marketing. 
Of course, shorter names tend to be easier to remember, and most short domain names 
are already in use. However, with a bit of creativity and brainstorming (see below) you 
should be able to come up with a catchy, easy-to-spell name. 
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Registering and setting up your domain name 

Have you chosen your domain name? Congratulations! The next step is to register your 
domain name with a registrar and point the domain name to your website. The cost of 
registering a domain name ranges from less than $10 USD to about $30 USD per year. 
You can register a domain from 1 to 10 years. The reason for the cost is that the central 
‘address book’ of all the world’s domain names needs to be updated – somebody’s got to 
pay for that! 
 
Now your website is ready to browse through the internet. 
 

Designing Web sites with Front Page 
 

How to Create a new web page using Microsoft Front page? 

In this step you will use the 'Start' button to open FrontPage and create a new blank 
page. 

1.  Click on the 'Start' button in the lower left of your computer screen 

      

2.  Go to 'All Programs' > 'Microsoft Office' > 'Microsoft Office FrontPage 2003' and 
click 

     

3.  Once FrontPage opens, click on the 'New Page' icon to create a new page in 
FrontPage 

      

4.  The new page should have a tab that has the heading 'new_page_1.htm' 
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In this step you will rename the new blank page you created in FrontPage and save it 
in the folder you have created on the Desktop.  

1.  Go to 'File' > 'Save As...' and click to open the window 

      

2.  When the window pops up, select the 'Change title...' button and title your page 
whatever you want  
     (I titled mine 'Sabrina's Autobiography Page') 
     Click on the 'File name:' window and name your page 'bio.htm' 
     Click on the 'Save' button 
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In this step you will choose the background of your page and then view the page in a 
browser window.  
 
Changing the Background and Preview the web page 

1.  Right click anywhere on the 'bio.htm' page to pull up the menu 

2.  Go to 'Page Properties...' and click 

      

3.  From the 'Page Properties' menu, navigate to the 'Formatting' tab and click 
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4.  Click on the pull down menu on 'Background' and then click on a color you want 
for the background 
     Then click on 'OK' 
 

      

5.  The entire 'bio.htm' page changes to that color 

6.  Go to 'File' > 'Save' to save the changes to your folder automatically 

7.  Click the 'Preview in Browser' icon on the toolbar to open a new window 

     

8.  This will allow you to view what your page will look like on the Internet 
     Use this option often to check your progress as you build your site 
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Creating a Table 

In this step you will choose a table size and modify the properties of the table.  

1.  Click on the 'Insert Table' icon in the toolbar 

      

2.  Highlight the number of cells you want to appear in your table and click 

      

3.  Right click on your new table to open the menu and click on 'Table Properties' 
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4.  The 'Table Properties' window allows you to change the size, alignment, width, 
cell spacing, border size and color, and background color of the table.  Experiment to 
get the look you want by clicking 'OK'. 
   
     Some things to note: 
 
     keep width of your table below 800 pixels to avoid horizontal scrolling on a monitor with 
800 x 600 resolution 

      'Cell padding' and 'Cell spacing' refer to the distance (in pixels) text and images will 
appear from the border 

 

cell padding/spacing of one... 
cell 
padding/spacing 
of five... 

 
 

      a border of zero will show a dashed line on the 'Split' view but no border on the 'Preview' 
view 
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border of 
zero... 

border of 
one... 

border of 
five... 

   

      Here is a sample layout... 
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In this step, you will learn how to modify individual cells in your table.  

1.  Right click on the cell you want to modify and on the menu click on 'Cell 
Properties' 

     

2.  The 'Cell Properties' window allows you to modify many parts of individual cells. 
     Use the pulldown menus to experiment with the look of the cells 
 
     A thing to note... 
 
     'Alignment' determines where in the cell font and graphics will appear 
 
     Here is an example of a layout... 
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3.  You may also merge the cell by highlighting the cells you want to merge into one 
     Right click to bring up the 'Merge Cells' command and select it 
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4.  Or split an individual cell into rows and columns by right clicking on the cell to 
bring up the menu  
     Select 'Split Cells...' 

      

     and then choose whether you want 'rows' or 'columns' and the number 

            

Changing the Font size and Font Colors 

In this step you will learn how to modify the font.  

1.  Highlight the font you want to change 

     

2.  Use any combination of the characteristics below 
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     a.  Change the font type by clicking on the pulldown arrow next to the font type 

           

      b.  Change the font size by either clicking on the pulldown arrow to select a 
number 

            

           or clicking on the 'A' icons on the toolbar to make the font larger or smaller 

                   

       c.  Change the font color by clicking on the 'Font Color' selector icon and 
choosing your color 
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In this step you will insert and modify graphics you find on Google.  

Insert a image 

1.   Click on the location you want the graphic on your page  
      Go to 'Insert' > 'Picture' > 'From File...'       
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2.   Navigate to your picture and select it and Click 'Insert' 

    

 

5.   An example of the finished result 
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6.  You may modify the picture by clicking on it and using the various tools on the 
'Picture Toolbar' 

      

7.  An example of the finished result 

     

Creating a Hyper link in a page 

In this step you will create hyperlinks. There are three types of hyperlinks: 
     1. links to outside websites 
     2. links to other pages in your website 
     3. links to places within the same document  

To link to an outside website (opens in a new window) 

1.  Highlight the text or graphic you want to link to an outside site 

      

2.  Click on the 'Hyperlink' icon on the toolbar to open the 'Insert Hyperlink' window 

http://viking.coe.uh.edu/~smarsh/fp2003/
http://viking.coe.uh.edu/~smarsh/fp2003/
http://viking.coe.uh.edu/~smarsh/fp2003/
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3.  Select the 'Target Frame...' button 
     Select 'New Window' 
     Click 'OK' 

      

3.  In the 'Insert Hyperlink' window, make sure 'Existing File or Web Page' is selected 
     Type in the full URL of the outside site in the 'Address' window 
     Click 'OK' 
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4.  The word is now linked 

Link to other pages in your website 

1.  Go to 'File' > 'New...' and select 'Blank page' from the menu that appears 

            

2.  Use the steps outlined in Step 3 to name and save the page 
3.  Highlight the text you want to link to the new page 

      

4.  Click on the 'Hyperlink' icon on the toolbar         

5.  Make sure you select the 'Existing File or Web Page' icon in the 'Hyperlink'  
window. Navigate to your 'biography' folder on the desktop and select the proper 
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.htm page. Do not select 'Target Frame...' > 'New Window' as you did in the 
previous example    Click 'OK' 

     

 

6.  The word is now linked 
Linking to a place within the same document 
1.  Click the cursor to the place in your document to which you want to navigate 
2.  Go to 'Insert' > 'Bookmark' and click 
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3.  A 'Bookmark' window will appear, name your bookmark   (In this case, I want to 
navigate from the bottom to the top of my page, so I named mine 'top')     Click 'OK' 

     

4.  A tiny 'flag' appears, representing a bookmark 
    (This flag will not appear when viewed in the browser) 
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5.  Highlight the text or image in your page from which you wish to navigate 
      (In this case, I highlighted 'top' since I am wanting to navigate from bottom to 
top)  

      

6.  Click on the 'Hyperlink' icon and choose 'Place in This Document' and the name of 
the bookmark 
     Click 'OK' 

     

 

7.  The area you highlighted is now linked to the bookmark 
     You may now 'jump' from one area to another within the same page 
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Fundamentals of HTML  

 

What is HTML 

HTML is a language for describing web pages. 

 HTML stands for Hyper Text Markup Language 
 HTML is not a programming language, it is a markup language 
 A markup language is a set of markup tags which are surrounded by angle brackets like 

<html>.HTML tags normally come in pairs like <b> and </b> 
 HTML uses markup tags to describe web pages  

HTML gives authors the means to: 

 Publish online documents with headings, text, tables, lists, photos, etc. 

 Retrieve online information via hypertext links, at the click of a button. 

 Design forms for conducting transactions with remote services, for use in searching for 
information, making reservations, ordering products, etc. 

 Include spreadsheets, video clips, sound clips, and other applications directly in their 
documents. 

 

 

Structure of an HTML File 

The most important tags are <html> and </html> - the entire document is contained within these two 

tags. The instruction here is simply "This is an HTML document". HTML comprises two major parts that 

give a document a well-structured look. They are:  

1- Head  : The Head contains the title of the document and the heading - which is the heading of 
that particular page in the document. The head section start with tag<head> and end with 
</head>. 
 

2- Body : The Body contains the entire content of the document. The body section start with tag 
<body> and end with </body>. 

 

You can create such a document using any text editor - even a very simple one like Windows Notepad. 

After finishing of the HTML codes, we can save the file with extension “.html”. To view an HTML 

document, you must use a browser (or similar software). The browser opens the HTML document in the 

background and "decodes" it before showing it to you. (ex. Home.html). 
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Example code for  home.html 

 

<html> 

<head> 

          <title> Home Page </title> 

</head> 

<body> 

         This is my first homepage. <b>This text is bold</b> 
 

</body> 

</html> 

 

Output 

 

 

 

What is HTML 

 

 To publish information for global distribution, one needs a universally understood language, a 

kind of publishing mother tongue that all computers may potentially understand.  The publishing 

language used by the www is HTML. 
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HTML gives authors the means to: 

 Publish online documents with headings, text, tables, lists, photos, etc. 

 Retrieve online information via hypertext links, at the click of a button. 

 Design forms for conducting transactions with remote services, for use in searching for 
information, making reservations, ordering products, etc. 

 Include spreadsheets, video clips, sound clips, and other applications directly in their 
documents. 

 

HTML files are nothing more than simple text files, so to start writing in HTML, you need nothing more 

than a simple text editor. Notepad is a common text editor (on Windows this is usually found under the 

Programs > Accessories menu). Type html codes and save the file as "myfirstpage.html". 

 

To look at HTML files, they don't even need to be on the web. Open a web browser such as Firefox or 

Internet Explorer and in the address bar, where you usually type web addresses, type in the location of 

the file you just saved (for example, "c:\html\myfirstpage.html") and hit return. Alternatively, go to the 

File menu of the browser, select Open, and browse for the file. 

 

Structure of a HTML page 

 

 <HTML> 

  <HEAD> 

   <TITLE> name of the document </TITLE> 

  </HEAD> 

  <BODY> 

   …………..page content …………….. 

   …………..page content……………… 

   …………..page content……………… 

  </BODY> 

 </HTML> 
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HTML tags 

 

1. <HTML> tag 

 

The first page structure in every HTML page is the <HTML> tag.  It indicates that the content of this file is 

in the HTML language.  All the text and HTML comments in a HTML page should go within the beginning 

and ending HTML tags. 

 

2. <HEAD> tag 

 

The <HEAD> tag specifies the line within the beginning and ending points of the tag are the prologue to 

the rest of the file.  Generally, only a few tags go into the <HEAD> portion of the page. 

 

3. <BODY>..</BODY> tag 

 

The remainder of the HTML page, including all the text and other content is enclosed within a <BODY> 

tag.  

 

4. <TITLE>...</TITLE> tag 

   The <TITLE> tag is used to show title of document in the title bar of the web browser. 

 

5. <H> tag 

   The header tag <H> is used to display the text in different font size. It has six types 

     

<H1>...</H1> - Largest heading size.    ex.  Heading1 

<H2>...</H2> - Large heading size.  ex.  Heading 2 
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<H3>...</H3> - Medium-big heading size.  ex.  Heading 3 

<H4>...</H4> - Medium-small heading size. ex.  Heading 4 

<H5>...</H5> - Small heading size. ex.  Heading 5 

<H6>...</H6> - Smalles heading size. ex.  Heading 6 

 

6. <P>…</P> tag 

  The Paragraph tag <P> is used display the in paragraph format and also align the text in left, right, 

center and Justify format. 

 

7. <OL>...</OL> tag 

  This tag is used to show list of items in ordered format. Each item is covered with <LI>..</LI> tag. 

    Example:       

          <OL> 

           <LI> red </LI> 

           <LI> green </LI> 

           <LI> blue </LI> 

        </OL> 

     

Output 

   1.red 

2.blue 

3.green 

 

7. <UL>...</UL> tag 

  This tag is used to show list of items in unordered format. Each item is covered with <LI>..</LI> tag. 

    Example:       
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          <UL> 

           <LI> red </LI> 

           <LI> green </LI> 

           <LI> blue </LI> 

        </UL> 

     

Output: 

 red  
 green  
 blue  

8. <B>...</B> tag 

   This is used to display text in bold face. 

 

     <B> bold</B> 

    Output: 

            bold 

 

9. <I>...</I> tag 

   This is used to display text in Italic style. 

 

     <I> Italic </I> 

    Output: 

            Italic 

 

10. <HR> tag 

     This used to draw single line. The <HR> is not need to closing tag </HR> 
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       <HR> 

   Output: 

       ____________________________________________________________________ 

 

11. <BR> tag 

      This is used to break line in a paragraph. 

 

12. <IMG> tag 

      This is used to include the image to html page with different size. 

  Example : <IMG src=“c:\bird.jpg”> 

  

13. <A> … </A> tag 

      This is used to create a hyper link for another page or image or file etc. The linked words are 

displayed in blue color with underlined. User click linking word then we can move to the linked page. 

 

  Example: <A href=“c:\main.html”> main </A> 

 

  Output :   main 

 

14. <Table>… </Table> tag 

      This tag is used to display items in tabular format with different color. 

15. <Tr>…</Tr> tag 

       It is used to create new row in a table. It is used inside the <Table> tag. 

16. <Td>…<Td> tag 

      It is used to display individual data item in a single row. It is used inside the <Tr> tag. 
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Ex : 

   <table border=1> 

     <tr> 

       <td>name</td>  <td> marks(100) </td> 

 </tr> 

    <tr> 

      <td>Mani</td>  <td> 95</td> 

 </tr>  

 <tr> 

           <td>sureh</td>  <td> 85</td> 

 </tr>  

      </table> 

 

Output : 

name marks(100) 

Mani 95 

sureh 85 

 

Simple HTML page 

 

 <HTML> 

  <HEAD> 

   <TITLE> MY FIRST WEB PAGE </TITLE> 

  </HEAD> 

  <BODY> 
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   <UL> 

   <L1> SOFTWARE 

   <OL> 

    <L1> COMPUTER CONCEPTS 

    <L1> MS-WORD 

    <L1> MS -EXCEL 

    <L1> MS-POWERPOINT 

    <L1> MS-ACCESS 

   </OL> 

   <L1> HARDWARE 

   <OL> 

   <LI> CPU 

   <LI> INPUT DEVICE 

   <LI> OUTPUT DEVICE 

   </OL> 

   </UL> 

  </BODY 

 </HTML> 

 

The out put for the above HTML program is as follows 
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1. C:\>ver      
 

Microsoft Windows XP [Version 5.1.2600] 
 
2. C:\>date 

The current date is: Thu 08/11/2011 
Enter the new date: (mm-dd-yy) 

 
3. C:\>time 

The current time is: 11:08:31.26 
Enter the new time: 

 
4. C:\>copy con student.txt 

mani 
ganesh 
suresh 
^Z 

          1 file(s) copied. 
 
5. C:\>type student.txt 

mani 
ganesh 
suresh 

 
6. C:\>rename student.txt stud.txt 
 
 7. C:\>dir 

 Volume in drive C has no label. 
 Volume Serial Number is EC7E-8DFC 
 
 Directory of C:\ 
 
06/08/2011  10:24 AM    <DIR>          annamalaiuniversity 
01/12/2011  10:13 AM                 0 AUTOEXEC.BAT 
01/12/2011  10:13 AM                 0 CONFIG.SYS 
06/11/2011  03:53 PM    <DIR>          Documents and Settings 
01/12/2011  02:54 PM    <DIR>          Intel 
04/20/2011  04:03 PM               882 menu.htm.html 
04/20/2011  04:03 PM    <DIR>          menu.htm_files 
08/05/2011  02:59 PM            11,770 PNET1 Query.txt 
07/25/2011  12:24 PM    <DIR>          Program Files 
08/11/2011  11:08 AM                22 stud.txt 
07/04/2011  02:38 PM    <DIR>          WINXP 
08/06/2009  12:00 AM    <DIR>          xampp 
               5 File(s)         12,674 bytes 
               7 Dir(s)  22,581,161,984 bytes free 



 
8. C:\>dir/w 

 Volume in drive C has no label. 
 Volume Serial Number is EC7E-8DFC 
 
 Directory of C:\ 
 
[annamalaiuniversity]    AUTOEXEC.BAT             CONFIG.SYS 
[Documents and Settings] [Intel]                  menu.htm.html 
[menu.htm_files]         PNET1 Query.txt          [Program Files] 
stud.txt                 [WINXP]                  [xampp] 
               5 File(s)         12,674 bytes 
               7 Dir(s)  22,581,161,984 bytes free 

 
9. C:\>md test 
 
10. C:\>cd test 
 
11. C:\test>cd.. 
 
12. C:\>copy stud.txt c:\test 
         1 file(s) copied. 
 

C:\>cd test 
 

C:\test>dir 
 Volume in drive C has no label. 
 Volume Serial Number is EC7E-8DFC 
 
 Directory of C:\test 
 
08/11/2011  11:11 AM    <DIR>          . 
08/11/2011  11:11 AM    <DIR>          .. 
08/11/2011  11:08 AM                22 stud.txt 
               1 File(s)             22 bytes 
               2 Dir(s)  22,581,161,984 bytes free 

 
13. C:\test>del stud.txt 
 

C:\test>dir 
 Volume in drive C has no label. 
 Volume Serial Number is EC7E-8DFC 
 
 Directory of C:\test 
 
08/11/2011  11:11 AM    <DIR>          . 



08/11/2011  11:11 AM    <DIR>          .. 
               0 File(s)              0 bytes 
               2 Dir(s)  22,581,166,080 bytes free 

 
C:\test>cd.. 

 
14. C:\>dir 

 Volume in drive C has no label. 
 Volume Serial Number is EC7E-8DFC 
 
 Directory of C:\ 
 
06/08/2011  10:24 AM    <DIR>          annamalaiuniversity 
01/12/2011  10:13 AM                 0 AUTOEXEC.BAT 
01/12/2011  10:13 AM                 0 CONFIG.SYS 
06/11/2011  03:53 PM    <DIR>          Documents and Settings 
01/12/2011  02:54 PM    <DIR>          Intel 
04/20/2011  04:03 PM               882 menu.htm.html 
04/20/2011  04:03 PM    <DIR>          menu.htm_files 
08/05/2011  02:59 PM            11,770 PNET1 Query.txt 
07/25/2011  12:24 PM    <DIR>          Program Files 
08/11/2011  11:08 AM                22 stud.txt 
08/11/2011  11:11 AM    <DIR>          test 
07/04/2011  02:38 PM    <DIR>          WINXP 
08/06/2009  12:00 AM    <DIR>          xampp 
               5 File(s)         12,674 bytes 
               8 Dir(s)  22,581,166,080 bytes free 

 
C:\>rd test 
 
C:\>dir 

 Volume in drive C has no label. 
 Volume Serial Number is EC7E-8DFC 
 
 Directory of C:\ 
 
06/08/2011  10:24 AM    <DIR>          annamalaiuniversity 
01/12/2011  10:13 AM                 0 AUTOEXEC.BAT 
01/12/2011  10:13 AM                 0 CONFIG.SYS 
06/11/2011  03:53 PM    <DIR>          Documents and Settings 
01/12/2011  02:54 PM    <DIR>          Intel 
04/20/2011  04:03 PM               882 menu.htm.html 
04/20/2011  04:03 PM    <DIR>          menu.htm_files 
08/05/2011  02:59 PM            11,770 PNET1 Query.txt 
07/25/2011  12:24 PM    <DIR>          Program Files 
08/11/2011  11:08 AM                22 stud.txt 



07/04/2011  02:38 PM    <DIR>          WINXP 
08/06/2009  12:00 AM    <DIR>          xampp 
               5 File(s)         12,674 bytes 
               7 Dir(s)  22,581,166,080 bytes free 

 



 1

    UNIT – V - Multimedia 

Basic Definition  

Multimedia can be defined as any combination of two or more of the following:-  

 Text  
 Graphics  
 Sound  
 Animation  
 Video  

Multimedia combines text, photographic images, video, animations and sound to provide 
the means to visualize and interact with information in a meaningful way. 

It makes electronic advertising more interesting as the television and movies by 
incorporating the sound and video checks into the computer presentation. 
 
The word multimedia simply means being able to communicate in more than one way for 
better interaction. 
 
In other words, execution of text, sound, graphics and animation simultaneously is the 
function of multimedia 
 
Hence the basic components of multimedia are text, sound, graphics, animation and 
video. A multimedia based computer must have all the needed hardware and software 
require to combine these components 
 

Application of Multimedia 
 
Multimedia technology can be used in variety of sectors. Virtual reality is the multimedia 
tool used for performing remote control applications. 
 
1. Entertainment 
     Software industry has developed lots of real life like games by in including text, 
graphics, sound and animation. 
     Virtual reality has made computer game adventure. Multimedia games allow children 
to experience the joy of driving cars of different type and model, fly aircraft play and 
musical instrument and so on. 
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2. Education 

In Education, multimedia is used to produce computer-based training courses  
(popularly called CBTs) and reference books like encyclopaedia and almanacs. A CBT 
lets the user go through a series of presentations, text about a particular topic, and 
associated illustrations in various information formats. Edutainment is an informal term 
used to describe combining education with entertainment, especially multimedia 
entertainment.  

They are used in training centers(eg.). In air force, candidates trained to control on 
aircraft using flight simulators. 

3. Medicine 

In Medicine, doctors can get trained by looking at a virtual surgery or they can simulate 
how the human body is affected by diseases spread by viruses and bacteria and then 
develop techniques to prevent it.  

4. Mathematical and Scientific Research 

In Mathematical and Scientific Research, multimedia is mainly used for modeling and 
simulation. For example, a scientist can look at a molecular model of a particular 
substance and manipulate it to arrive at a new substance. Representative research can be 
found in journals such as the Journal of Multimedia.  

5. Engineering 

Software engineers may use multimedia in Computer Simulations for anything from 
entertainment to training such as military or industrial training. Multimedia for software 
interfaces are often done as collaboration between creative professionals and software 
engineers.  

6. Business 
 
Multimedia is used in business to enhance quality of the business communication. Now 
we can advertisement and corporate presentation, incorporating multimedia or video 
conferencing, Another activity that involves multimedia to get together for discussion on 
the internet. 
 

Elements of Multimedia 
Text: 
         This involves displaying words on the screen. This is used to provide a lot of 
information, so program always used it. Text appearance can be made attractive and 
impressive using special tools namely bold face, blink, underline etc., 
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Graphics or Pictures 
       Computer can also produce photograph quality images on the screen explaining 
topics using pictures along with text will make the audience understand the topic better. 

However, different graphics formats are available which take less space and are faster to 
load into the memory. 

 Animation 
       Moving images have an overpowering effect on the human peripheral vision. 
Followings are few points for its popularity.   
Sometimes animation can explain aspect better than movies. 

 Eg. A) The feet moment of a dinosaur can be explained in details through animation. 
        B) Automobile industry use animation to study event like vehicle accident to  
           make driving safer. 
 c) Film industry use animation to create a non-existing artificial world. 
 

Audio 
Audio has a greater role to play in multimedia development. It gives life to the static 

state of multimedia. Incorporation of audio is one of the most important features of 
multimedia, which enhance the multimedia usability to its full potential. There are several 
types of sound, which can be used in multimedia. They are human voices, instrumental 
notes, natural sound and many more. All these can be used in any combination as long as 
they give some meaning to their inclusion in multimedia.  

 
Video or Movies 
     A computer can be turned into a television using a multimedia program. Video 
regarding like family movies stored on CD, entertainment movies, educated movies can 
be played. 
 

Beside animation there is one more media element, which is known as video. With 
latest technology it is possible to include video impact on clips of any type into any 
multimedia creation, be it corporate presentation, fashion design, entertainment games, 
etc. 
 

Hardware and Software Requirements 

For producing multimedia you need hardware, software and creativity. In this section 
we will discuss the multimedia equipment required in a personal computer (PC) so that 
multimedia can be produced.   

(a) Central Processing Unit 

As you know, Central Processing Unit (CPU) is an essential part in any computer. It is 
considered as the brain of computer, where processing and synchronization of all 
activities takes place. The efficiency of a computer is judged by the speed of the CPU in 
processing of data. For a multimedia computer a Pentium processor is preferred because 
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of higher efficiency. In today’s scenario, a Pentium processor with MMX technology and 
a speed of 166 to 200 MHz (Megahertz) is an ideal processor for multimedia.   
 
(b) RAM 
In addition to the processor one will need a minimum 16 MB RAM to run WINDOWS to 
edit large images or video clips. But a 32 or 64 MB RAM enhances the capacity of 
multimedia computer.  

(b) Monitor  

As you know that monitor is used to see the computer output. Generally, it displays 25 
rows and 80 columns of text. The text or graphics in a monitor is created as a result of an 
arrangement of tiny dots, called pixels. Resolution is defined in terms of horizontal and 
vertical pixel (picture elements) displayed on the screen. The greater the number of 
pixels, better visualization of the image. 

c) SVGA Adapter card 

The signals that monitor gets from the processor are routed through a graphics card. But 
there are computers available where this card is in-built into the motherboard. This card 
is also called the graphics adapter or display adapter. This card controls the individual 
pixels or tiny points on a screen that make up image. There are several types of display 
adapter available. But the most popular one is Super Virtual Graphics Arrays (SVGA) 
card and it suits the multimedia requirement. The advantage of having a SVGA card is 
that the quality of graphics and pictures is better. 

d) Video Grabbing Card 
 
This card is fitted into a free slot on the motherboard inside the computer and gets 
connected to an outside source such as TV, VCR or a video camera with the help of a 
cable. This card receives both video and audio signal from the outside source and 
conversion from analog to digital signal takes place. This process of conversion is known 
as sampling. 
 
e)  Sound Card with Speakers 
This is installed into a free slot on the computer motherboard. As in the case of video 
grabber card, sound card will take the sound input from outside source (such as human 
voice, pre-recorded sounds, natural sounds etc.) and convert them into digital sound 
signal of 0’s and 1’s. The recording software used along with the sound card will store 
this digitized sound stream in a file. This file can latter be used with multimedia software. 
 
f) Graphics accelerator card 
Generating graphics takes up considerable amount of system resources. This slows the 
moving pictures that don’t move smoothly. The graphics accelerator card takes 
responsibility of generating pictures and screen without the interaction of CPU generating 
excellent output of pictures and movies. 
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g) CD-ROM Drive 

CD-ROM is a magnetic disk of 4.7 inches diameter and it can contain data up to 680 
Megabytes. It has become a standard by itself basically for its massive storage capacity, 
faster data transfer rate. To access CD-ROM a very special drive is required and it is 
known as CD-ROM drive. Let us look into the term ROM that stands for ‘Read Only 
Memory’. It means the material contained in it can be read (as many times, as you like) 
but the content cannot be changed.  

As multimedia involves high resolution of graphics, high quality video and sound, it 
requires large amount of storage space and at the same time require a media, which can 
support faster data transfer. CD-ROM solves this problem by satisfying both 
requirements.  

Similar to the hard disk drive, the CD-ROM drive has certain specification which will 
help to decide which drive suit best to your multimedia requirement. 

h) 1GB Hard disk or above 
i) Key board and Mouse 
j) Mic 
 
 

Hypertext 
 
Hypertext most often refers to text on a computer that will lead the user to other, related 
information on demand. Hypertext represents a relatively recent innovation to user 
interfaces, which overcomes some of the limitations of written text. Rather than 
remaining static like traditional text, hypertext makes possible a dynamic organization of 
information through links and connections (called hyperlinks). 
 
Hypertext can be designed to perform various tasks; for instance when a user "clicks" on 
it or "overs" over it, a bubble with a word definition may appear 

Hypertext contains connections within the text to other documents or locations. Hypertext 
allows non-sequential reading and writing of documents by using embedded links to 
jump from one place in the document to another; hopefully in a meaningful way. The 
cross reference links are determined by the author but the user chooses which branches to 
take.  

Hypermedia 

Hypermedia is used as a logical extension of the term hypertext, in which graphics, 
audio, video, plain text and hyperlinks intertwine to create a generally non linear medium 
of information. 
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Hypermedia documents contain links not only to other pieces of text, but also to other 
forms of media:  

 sounds  
 pictures  
 movies  
 animations  

The destination of a link is a node. Pictures may also be used to link to other nodes. 
Hypermedia simply combines hypertext and multimedia. It allows authors to connect 
information in diverse ways, allowing users to explore a complex web of interlinked 
information according to their needs and interests. 

Sound 
The multimedia application user can use sound right off the bat on a multimedia PC 
running Windows because beeps and warning sounds are available as soon as the 
operating system is installed. In Windows system sounds are WAV files and they reside 
in the windows\Media subdirectory. 
 
There are still more choices of audio if Microsoft Office is installed. Windows makes use 
of WAV files as the default file format for audio. 
 
Digital Audio 
 
Digital audio is created when a sound wave is converted into numbers – a process 
referred to as digitizing. It is possible to digitize sound from a microphone, a synthesizer, 
existing tape recordings, live radio and television broadcasts, and popular CDs. You can 
digitize sounds from a natural source or prerecorded. 
 
Audio File Formats 
A file format determines the application that is to be used for opening a file. Following is 
the list of different file formats and the software that can be used for opening a specific 
file. 
1. *.WAV for Windows Systems 
2. *.WMA –windows media player 
3. *.MP3 – MP3 audio 
4. *.RA – Real Player 
 
Sound Recorder 
     It can be used both to play and record sound. To record sound a microphone is 
required. The microphone is also plugged into sound card. It can record maximum of 1 
minute audio in “WAV” format. 
 
Media Player 
     This is a versatile media player by Microsoft and can play audio and video file. It can 
also play Audio CD and Video CD. 

http://ksi.cpsc.ucalgary.ca/courses/547-95/mathezer/hypertex.html
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Images 
       The display on screen depends on the display cards. Display cards that support large 
number of colour better. They are pixel based images available in file format like TIF, 
GIF, BMP, JPEG 
      The quality can be good if care is taken during scanning and if atleast 256 colors are 
used. Software such adobe and Photoshop give good control over the image scanning 
devices like scanner or flat-bed scanner can be connected to the computers. So that 
scanned image is stored directly in your CPU. 
       Images can be created using images editing software like photoshop, paintbrush, 
coreldraw etc., Images created can stored in different file format. Some of the common 
file formats are TIF, GIF, BMP, JPEG. 
 

Animation 
 
It is a single graphic file that depicts movement for instance. This is achieved by super 
imposing, several still picture in pre-defined sequence. The time interval that each  frame 
remains can specified to achieve the results. If the frames move too slowly or too fast, the 
animation is not smooth. The speed at which the images are displayed is called the frame 
rate and measured as frame per second. 
 
Generally the minimum frame rate for acceptable animation is about 15 frames/sec. 
Which move at a speed that allows us to recognize images as being separate but is still 
watchable. The ideal rate for animations is 30 fps which matches video frame rate. Most 
of multimedia computers are capable of playing back 30 fps animation and video 
 
Morping 
 
      Morphing is popular effect in which one image transforms into another. It is also 
related animation. It is technique that allows smooth changes to occur to an object shape 
by defining beginning, ending and possibly intermediate forms as guides.  
      Following is the list of few Software used for computerized animation: 

 3D Studio Max 
 Flash 
 AnimationPro 

 
 

Video 

The advantage of integrating video into a multimedia presentation is the capacity 
to effectively convey a great deal of information in the least amount of time. Remember 
that motion integrated with sound is a key for your audience's understanding. It also 
increases the retention of the presented information (knowledge). 
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Digitizing the Video Signal 

There are two basic approaches to delivering video on a computer screen – analogue 
and digital video.  

 Analogue video is essentially a product of the television industry and therefore 
conforms to television standards.  

 Digital video is a product of the computing industry and therefore conforms to 
digital data standards. 

Video, like audio. Is usually recorded and played as an analog signal. It must 
therefore be digitized in order to be incorporated into a multimedia title.  

Figure below shows the process for digitizing an analog video signal. 

 

      A video source, such as video camera, VCR, TV, or videodisc, is connected to a 
video capture card in a computer. As the video source is played, the analog signal is sent 
to the video card and converted into a digital file that is stored on the hard drive. At the 
same time, the sound from the video source is also digitized. 

Advantages of Digital Video 

One of the advantages of digitized video is that it can be easily edited. Analog video, 
such as a videotape, is linear; there is a beginning, middle, and end. If you want to edit it, 
you need to continually rewind, pause, and fast forward the tape to display the desired 
frames. 

Digitized video on the other hand, allows random access to any part of the video, and 
editing can be as easy as the cut and paste process in a word processing program. In 
addition, adding special effects such as fly-in titles and transitions is relatively simple. 
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Other advantages: 

 The video is stored as a standard computer file. Thus it can be copied with no loss 
in quality, and also can be transmitted over standard computer networks. 

 Software motion video does not require specialized hardware for playback.  

Unlike analog video, digital video requires neither a video board in the computer nor an 
external device (which adds extra costs and complexity) such as a videodisc player. 

The common digital video formats are : 

 Motion Pictures Expert Group (.MPEG) 
 Video for Windows (.AVI).  

 
Development of Multimedia Projects 

 
 Most multimedia and web projects must be undertaken in stages. Some stages 
should be completed before other stages begin and some stages may be skipped or 
combined. Here are four basic stages in multimedia project. 
 

1. Planning and costing 

2. Designing and producing 

3. Testing 

4. Delivering  

 
1. Planning and Costing 
 A project always begins within a idea or a need identify how you will make each 
message within your system before you begin developing plan what writing skill, graphic 
art, music, video and other multimedia expertise will be required. Estimate the time 
needed to do all elements and prepare a budgets prepare a proof of concept. 
 
2. Designing and Producing 
 Perform each of the planned tasks to create finished products. 
 
3. Testing 
 Always test your programs to make sure that they meet the requirements of your 
projects. 
 
4. Delivering 
 Package and deliver the project to the end user. This stage has several steps such 
as implementation, maintenance, shipping and marketing the product. 
 


